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1. Creation of the Forest Resource Database 

1.1. Operation procedure for updateing Concession areas on the new FIMS 

Method A : Import from Mapinfo TAB file 
Method B : Digitize concession area by the new FIMS 
 
Method A : Import from Mapinfo TAB file 
Steps 
1. Convert the data from TAB to SHP by MapInfo 
2. Confirm and Edit attribute fields 
3. Convert geometry type of shape-file from “Polygon ZM” to “Polygon”. 
4. Edit attribute values 
5. Import the shape-file into new FIMS. 
6. Run re-calculation. 
 
1. Convert the data from TAB to SHP by MapInfo 
1-1.Start MapInfo. 
1-2.Choose [Tools]>[Universal Translator]. 
1-3.In Universal Translator window, select the Format and set the File to be converted 
and destination directory. 

Source Format>Mapinfo TAB 
Destination Format>ESRI Shape 

1-4.Click OK to run converting. 
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2.Confirm and Edit attribute fields by ArcGIS 
To import the data into new FIMS, you need to confirm attribute fields by ArcGIS. 
If there is any differences, you need to edit the attribute fields by ArcGIS. 
New FIMS can import a following shapefile having attribute fields. 
 

Name Type Remarks mandatory 
PROVINCE Double Province to which the Concession Area 

belongs 
◯ 

PLAN_ID Double Plan_id ◯ 
STATUS Test Input the status of either of the following 

“Concession” or “Proposed” 
◯ 

AREA Double Extent of Concession Area (units: ha)  
purchase Date   
Exp Date   
CONSTYPE Text   
SCALE Text   
NAME Text Concession Area name  

 
If the shape file does not have “PROVINCE” attribute field, you need to add the field. 
2-1. Start ArcMap or ArcCatalog. 
2-2. Choose [ArcToolbox]>[Data Management Tools]>[Fields]>[Add Field] 
2-3.Select the target shape-file in Input Table. 
2-4.Add “PROVINCE” in Field Name. 
2-5.Select “DOUBLE” in Field Type. 
2-5.Click OK. 
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3.Convert geometry type of shape-file from “Polygon ZM” to “Polygon” 
After converting from Tab-file, the geometry type of shape-file become “Polygon ZM”. 
You have to change the geometry type because new FIMS can import only the geometry 
type “Polygon”. 
3-1. Start ArcMap or ArcCatalog. 
3-2. Choose [ArcToolbox]>[Conversion Tools]>[To Shapefile]>[Feature Class to 
Shapefile(multiple)] 
3-3. In Feature Class To Shapefile(multiple) window, set the File to be converted and 
destination directory. 
3-4. Click on the Environments, then set output area of M Values and Z Values to 
Disabled. 
3-5. Click OK to run converting. The new shape-file is generated.  
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4. Editing attribute values by ArcMap 
4-1.Open the shape-file converted to polygon type. 
4-2.Open attribute table. 
4-3.Choose [Editor]>[Strat Editing] 
4-4.Editing the values. 

 “PROVINCE” , “PLAN_ID” and “AREA” field can have only a numeric value. 
Delete character string if the value is having that.  

 “purchase” and “Exp” field can have mm/yyyy value. Change the value as 
necessary. 

 If attribute value is null, you do not need to edit the field. 
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5. Import the shape-file into new FIMS 
5-1.Strat new FIMS. 
5-2.Select the Province. 
5-3.Click on the Large Map button to open Map Window . Move to the location of new 
concession area on the map. 
5-4.Click on the Import button. 
5-5. Select the ConcessionArea and set the Shape-file to be imported, and check the Add 
Box. 
5-6.Click OK to import. SQLServer database of FIMS will be updated. 

 
 
5-7. Edit attribute of the concession 
Editor > Start editing 
If Start Editing window open, select “dbo.DEFAULT – PNGFA-HQ-SRV3” 

 
Then Select target layer you want to edit. 
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Click on the “Attribute”, then Concession Attribute windou will open and you can edit 
attribute values. 
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5-8. You Can also overlay the shape-file to be imported. Click Add layer button and 
select the shape-file. This function can see shape-files temporary, the SQL Server 
database is not updated.  

 
6. Run re-calculation 
6-1. Click on the FMU Caluculation button. 
6-2. Choose FMU Tab and select Provinces to be re-calculated. The FMU layer is 
updated. 
6-3. Choose Concession Tab and select Provinces to be re-calculated. The Concession 
table is updated. 
6-4. You can see the result in the main window or by printing reports.  
 
 
Method B : Digitize concession area by the new FIMS 
Steps 
1. Scan the map 
2. Georeference the scanned Image 
3. Overlay the georectified map on the new FIMS 
4. Digitize a shape and enter attribute values on the new FIMS 
5. Run re-calculation 
 
Exercise : Digitize Annual logging map to enter “Logged_NotLandUse” polygon. 
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NOTE 
Method A and Method B are applicable to other layers(Logged Over area, Protected area, 
Logging Plan area). 
When you import from shape-file, confirm attribute fields of each layer. 
 
Logged Over area 

Name Type Remarks mandatory 
PROVINCE Double Province that the Logged Over Area belongs to ◯ 
AREA Double Extent of Logged Over Area (manual input, 

units: ha) 
 

AREA2 Double Extent of Logged Over Area (automatic input, 
units: ha) 

 

TYPE Text Logged Over Area type  
ACHARVOL Double Actual harvest Volume  
PLAN_ID Double Plan id of the Concession to which the Logged 

Over Area belongs 
 

YEAR Text The date of the Logged Over Area is input in 
the following format 
Format: mm/yyyy 

 

NAME Text Logged Over Area name  
 
Protected area 

Name Type Remarks mandatory 

PROVINCE Double Province to which the Protected Area belongs ◯ 

PROTECT_ID Double Protected Area ID  

NAME text Protected Area name  

TYPE text Protected Area type  

GAZ_DATE Text Designated date by protected area  

LOCATION Text protected area’s location (Character string )  

TENURE Text protected area’s holder  

AREA Double Extent of Protected Area (units: ha)  

ALTITUDE Text altitude description  
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Name Type Remarks mandatory 

LOGITUDE Text protected area’s location (longitude )  

LATITUDE Text protected area’s location (latitude)  

 
Logging Plan area 

Name Type Remarks mandatory 

PROVINCE Double Province to which the Plan Area belongs ◯ 

AREA Double Extent of Plan Area (units: ha)  

AREA2 Double Extent of Plan Area (automatic input, units: ha)  

TYPE Text Plan Area type  

PRJHARVOL Double Project harvest Volume  

PLAN_ID Double Plan id of the Concession to which the Plan Area 

belongs 

 

YEAR Text The date of the Plan Area is input in the following 

format 

Format: mm/yyyy 

 

NAME Text Plan Area name  
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1.2. Operation procedure for importing logged and land use areas into new 

FIMS 

Steps 
1. Converting the data from TAB to SHP by MapInfo 
2. Editing attribute fields 
3. Convert geometry type of shape-file from “Polygon ZM” to “Polygon”. 
4. Editing attribute values 
5. Importing the shape-file into new FIMS. 
6. Running re-calculation. 
 
1. Converting the data from TAB to SHP by MapInfo 
1-1.Start MapInfo. 
1-2.Choose [Tools]>[Universal Translator]. 
1-3.In Universal Translator window, select the Format and set the File to be converted 
and destination directory. 

Source Format>Mapinfo TAB 
Destination Format>ESRI Shape 

1-4.Click OK to run converting. 

 

 
2.Editing attribute fields by ArcMap 
To import the data into new FIMS, you need to edit attribute fields by ArcGIS, because 
there are differences in attribute fields. 

 New FIMS need the attribute “province” in logged and land use layer. 
 But the shape-file converted from Tab-file does not have this field. 

2-1. Start ArcMap or ArcCatalog. 
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2-2. Choose [ArcToolbox]>[Data Management Tools]>[Fields]>[Add Field] 
2-3.Select the target shape-file in Input Table. 
2-4.Add “province” in Field Name. 
2-5.Select “DOUBLE” in Field Type. 
2-5.Click OK. 
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3.Convert geometry type of shape-file from “Polygon ZM” to “Polygon” 
After converting from Tab-file, the geometry type of shape-file become “Polygon ZM”. 
You have to change the geometry type because new FIMS can accept only the geometry 
type “Polygon”. 
3-1. Start ArcMap or ArcCatalog. 
3-2. Choose [ArcToolbox]>[Conversion Tools]>[To Shapefile]>[Feature Class to 
Shapefile(multiple)] 
3-3. In Feature Class To Shapefile(multiple) window, set the File to be converted and 
destination directory. 
3-4. Click on the Environments, then set output area of M Values and Z Values to 
Disabled. 
3-5. Click OK to run converting. The new shape-file is generated.  
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4. Editing attribute values by ArcMap 
4-1.Open the shape-file converted to polygon type. 
4-2.Open attribute table. 
4-3.Choose [Editor]>[Strat Editing] 
4-4.Editing the values. 

 AREA field of new FIMS can have only a numeric value. Delete character string.  
 YEAR field of new FIMS can have mm/yyyy value. Change the value. 
 Enter province code.(you can also enter province code on new FIMS) 

4-5.Choose [Editor]>[Save Edits] to save  and [Editor]>[Stop Editing] when you finish 
editing. 
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5. Importing the shape-file into new FIMS 
5-1.Strat new FIMS. 
5-2.Select the Province and click on the Concession button to select the concession area. 
5-3.Click on the Large Map button to open Map Window . 
5-4.Click on the Import button. 
5-5. Select the destination layer of (among LoggedNotLandUse_Current, 
LoggedLandUse_Current, LandUseNotLogged_Current) and set the Shape-file to be 
imported, and check the Add Box. 
5-6.Click OK to import. SQLServer database of FIMS will be updated. 

 
5-7. You Can also overlay the shape-file to be imported. Click Add layer button and 
select the shape-file. This function can see shape-files temporary, the SQL Server 
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database is not updated.  

 

6. Running re-calculation 
6-1. Click on the FMU Caluculation button. 
6-2. Choose FMU Tab and select Provinces to be re-calculated. The FMU layer is 
updated. 
6-3. Choose Concession Tab and select Provinces to be re-calculated. The Concession 
table is updated. 
6-4. You can see the result in the main window or by printing reports.  
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1.3. Operation procedure for importing survey results into new FIPS 

New FIPS provides two options to enter the survey results (field book data). 
Method 1) Enter data to FIPS directly (existing function) 
Method 2) Import from Excel spreadsheet (new function) 

→This manual is showing Method 2. 
 

Steps 
1. Enter information for a new survey 
2. Input the field book data into an excel spreadsheet 
3. Import the field book data from the excel spreadsheet into new FIPS 
4. Run calculation, print reports and output to excel file 
 
1. Enter information for a new survey 
1-1.Start FIPS. 

Click FIPS-Startup on the desktop, input ID and PASSWORD, then main window will 
open.  
In case Security warning appears, Click on “Options” and select “Enable this content”. 
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1-2. Click on the “ENTER INFORMATION FOR A NEW SURVEY” button. 

 
1-3. Enter the details of the survey. 

 
(1) Survey Number (Mandatory Item) 

Check the last number which has been used already in the main window.  
The survey number is a five digit numeric code with the first two digits the 
province number and the last three a number from 001 to 999. 

(2) Name of survey (Mandatory Item) 
Can be entered up to 20 characters.  

(3) Date of survey  
Completion date. The format of date is DD/MM/YYYY. ( Eg. 01/06/2012) 

(4) Gross area in hectares (Optional) 
Enter the gross area of resource area in hectares. The area must be an integer 

 

(１) 

(2) 
(3) 
(4) 
(5) 
(6) 

(7) 

(8) 
(9) 

(10) 

(11) 

(12) 
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number (whole number). If you recorded the area as a decimal number, you need 
to round it off to the nearest whole number. 

(5) File / Ref .Number 
(You can skip over entering this information.) 

(6) Number of blocks 
Enter the number blocks. 

(7) Area of Block 
Enter the area of each block in hectares. The area must be an integer number. If 
you recorded an area as a decimal number, you need to round it off to the integer 
number. 
The entry number of Area of Block is the same with the value of “Number of 
Blocks”. If the value of “Number of Blocks” is “2”, then “Area of Block 01” and 
“Area of Block 02” should be filled. 

 (8) Plan ID (Optional) 
Plan ID is for Plan ID of the concession area in FIMS. 
You need to confirm the PlanID by FIMS. 
If you enter the PlanID, you can link the survey result to the related FIMS 
concession area, and see in FIMS the estimated forest volume which is calculated 
by FIPS. 

(9) Virgin, LOI or Unlogged Forest Survey 
Choose virgin or LOI. 

 (10) Vegetaion (Optional) 
Select the representative vegetation type in the survey area 

(11) Topography (Slope and Elevation) (Optional) 
Enter minimum and maximum value for slope and elevation. 

(12) Adjusted Net Forest Area (in hectares) (Optional) 
Enter the adjusted net forest area as an integer number. 

 
1-4. Click OK, then Survey information will be saved. 
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2. Input the field book data into an excel spreadsheet 
To import the field book data into new FIPS, you need to use the excel spreadsheet 
“FIPS Import Data Creator” which new FIPS provides. 
The Excel spreadsheet is “FIPS_ImportDataCreator.xls” in C:¥fips¥macro. 
If Security warning appears, Click on “Options” and select “Enable this content”. 

 
 
2-1. Specify output path of the result Excel file (1) 

Click on the select button, and select a directory where you want to place the excel file 
“ImportData.xls” as the import data. 
If you want to place “ImportData.xls” on desktop, select Desktop as below, then click 
on the save button. 

(1)

(2)

(3)

(4) (5)

optional

optional
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2-2. Select Plot Type and Forest Type (2) 

Plot Type and Forest Type are mandatory. Refer to [Reference] sheet for the code. 
 

2-3. Input of Tree information (3) 
You can copy from existing excel spreadsheets which you have kept. 
“Strip No.”, “Plot No.”, “Tree No.”, “Species Code”, ” Form”, “Diameter” and “Height” 
need to be entered into the spreadsheet “FIPS Import Data Creator”. There is no 
need to enter “Volume”. 
If you want to clear all entered data, click on the clear button. (5) 

 
2-3-1. Copy from existing excel spread datasheet 

 
Attention 
Delete blank line before copy. Don’t remain the blank line. 

  

  

Copy “Strip No.”, “Plot No.”, 
“Tree No.”, “Species Code”, 
“Form”, “Diameter”, and 

“Height”. 
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Otherwise, the data below the blank line are not imported. 

 
 
2-3-2. Paste into the  FIPS_ImportDataCreator 

 

2-3-3. The case for the separate field data files 
When you have separate field data sheet (e.g. pulp log and sawlog), copy and paste 
other field data again. 
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2-4. Execution of process (4) 

Execute the process by clicking the “Create Import Data” button. 
A confirmation dialog is displayed, after finishing the process. 

 

 
Cells will be filled in, in yellow if there are errors. 
Species Code has to be selected from species list in [Reference] sheet. You need to 
change it to the species code which [Reference] sheet shows. 

 
2-5. Save “FIPS Import Data Creator” with a different name. It is better to add the 
survey name to the original excel file name. 

Eg. FIPS_ImportDataCreator_vanimo_LOI.xls 
 
2-6. Open the excel file saved in 2-5 and add the GPS information for start point an end 
point of strip (The case for adding GPS information). 

The excel file is listed by the plot, but GPS information is measured for each strip. You 
have to copy the GPS information into all plots for each strip. 
After adding GPS information, save the data. 

 

  
Don’t remain the 

blank line. 
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Note: You can add the GPS information by FIPS directly (See step3-6). 

 
3. Import the field book data from the excel spreadsheet into new FIPS 
After exporting the excel file “ImportData.xls” from “FIPS Import Data Creator”, you 
can import the excel file “ImportData.xls” to new FIPS. 
3-1. Select the survey name from the FIPS main window. 
3-2. Click on the DETAILS/STATUS button. 

If you already have the "Details And Processing Status of a Survey" Screen of the 
survey open, you can go to the next step 3-3. 
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3-3. Detail And Processing Status of a Survey screen is open, then click on the ENTER 
DATA button. You need to enter the field book data in every block. 

 
3-4. Click on IMPORT FROM EXCEL FILE button, then select the excel file  
“ImportData.xls” exported at step2-4 (You should select an excel file which is built with  
“FIPS Import Data Creator”.).  

 

3-5. Click on the OK button, then click on the Cancel button. 
 
3-6. Add the GPS information by FIPS, if the GPS information has not included in the 
excel file “ImportData.xls” exported at step2-4. 

Open the “Edit of Field Book Data” window for each strip number and enter the GPS 
information, then the GPS information is reflected for all of plot data that has 
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surveyed in the same strip. 
 

 
 
4. Run calculation(PROCESSING) , print reports and output to excel file 
4-1.After importing the Excel file, the PROCESSING button will become active. 

 
4-2. Click on the PROCESSING button, then the result will be calculated. 

If processing is successful, a confirmation window appears and shows "Processing 
Completed".  
After Clicking on the Ok button, the RESULT button will become active. This means 
that the Processing is finished. Therefore you can confirm several reports of the 
survey. 
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4-3.If you click on the PRINT WHOLE SURVEY RESULTS, you can see all reports. 

You can switch between printing Single Block or Whole Survey reports by pressing 
the “Please select” radio button. 

 
4-4.Click on the Result button, then you can output the result of the processing to an 
excel file. You can edit it for any purpose. 
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Specify where to save the file and its name. 

 
The contents of the exported Excel file are followings: 

Field  Field Name Contents/Comments 
1 SPEC_CODE Species Code 
2 SPEC_NAME Species Name 
3 A_VOL10 10-19cm Volume of Form A 
4 B_VOL10 10-19cm Volume of Form B 
5 C_VOL10 10-19cm Volume of Form C 
6 D_VOL10 10-19cm Volume of Form D 
7 E_VOL10 10-19cm Volume of Form E 
8 F_VOL10 10-19cm Volume of Form F 
9 TOTAL_VOL10 Total 10-19cm Volume 
10 VOL10_PER_HA 10-19cm Volume per Hectare 
11 COMP_VOL10 Percent of 10-19cm Volume 
12 BA10 Total 10-19cm Basal Area 
13 A_PVOL 20-49cm Volume of Form A 
14 B_PVOL 20-49cm Volume of Form B 
15 C_PVOL 20-49cm Volume of Form C 
16 D_PVOL 20-49cm Volume of Form D 
17 E_PVOL 20-49cm Volume of Form E 
18 F_PVOL 20-49cm Volume of Form F 
19 TOTAL_PVOL Total 20-49cm Volume 
20 PVOL_PER_HA 20-49cm Volume per Hectare 
21 COMP_PVOL Percent of 20-49cm Volume 
22 PBA Total 20-49cm Basal Area 
23 A_SVOL 50cm+ Volume of Form A 
24 B_SVOL 50cm+ Volume of Form B 
25 C_SVOL 50cm+ Volume of Form C 
26 D_SVOL 50cm+ Volume of Form D 
27 E_SVOL 50cm+ Volume of Form E 
28 F_SVOL 50cm+ Volume of Form F 
29 TOTAL_SVOL Total 50cm+ Volume 
30 SVOL_PER_HA 50cm+ Volume per Hectare 
31 COMP_SVOL Percent of 50cm+ Volume 
32 SBA Total 50cm+ Basal Area 
33 SPEC_GROUP Species Group(= Mep Group) 
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2. Use of the Forest Resource Database 

2.1. Overview of FIMS database in SQL Server of pngfa-hq-srv3 server 

The data of the new FIMS are stored in ArcGIS GeoDatabase ”geodb01” as the database 
of SQL Server. You can use the FIMS data by ArcMap10 and Microsoft Access2010 
without FIMS. 

 
“geodb01” is a database name in SQL Server, which stores FIMS map data. 
 Centralized management of a wide variety of geographic information. 
 Large data management in a continuous integrated environment (raster/vector) 

The following specific users can only access “geodb01” and edit values(shape and 
attribute). (As of 5/2/2014): 

pngfa¥jicasupport 
pngfa¥cbigol 
pngfa¥pmalan 
pngfa¥plaa 
pngfa¥jantiko 

CLIENT PC(GIS_PC_01-06) PNGFA-HQ-SRV3 

SQL Server 2008 

geodb01 

FIMS database 

FIMS 

ArcCatalog10 
ArcMap10 

Microsoft Access2010 
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2.2. Access to the FIMS database “geodb01” from ArcMap10 or ArcCatalog10 

2-1. Create a direct connection to the FIMS database from ArcGIS Desktop 
If you want to use FIMS database “geodb01” directly without FIMS, you need to make 
a spatial database connection.  
This configuration is needed for accessing first time to the database. From next time, 
you can connect easily. 

(1) Start ArcCatlog. 
(2) Double click “Add Spatial Database Connection” under “Database 
Connections” in Catalog Tree. 

 
 
(3) You need to fill the “geodb01” information after ”Spatial Database Connection” 
window open. 

Server: “pngfa-hq-srv3” 
Service: “esri_sde” 
Database: “geodb01” 
Account: select “Operating system authentication” 
Connection details: Click on the Change button and select “dbo. DEFAULT” 
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The database connection will be established, then you can see the FIMS map 
tables. 

 
 

(4) If you have already established database connection once, it is only necessary 
to select “connection to pngfa-hq-srv3” in the database connection. 
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2-2. Display the FIMS map layers by using ArcMap10 

You can open the FIMS map layers as same as opening shape-file. 
 
FIMS map layers in “geodb01” are as follows: 
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geodb01.DBO.FMU 
geodb01.DBO.ConcessionArea 
geodb01.DBO.Logged_NotLandUse_Current 
geodb01.DBO.LandUse_NotLogged_Current 
geodb01.DBO.Logged_LandUse_Current 
geodb01.DBO.PlanArea 
geodb01.DBO.Protected_Area 
geodb01.DBO.Extreme_Altitude 
geodb01.DBO.Extreme_Inundation 
geodb01.DBO.Extreme_Karst 
geodb01.DBO.Extreme_Mangrove 
geodb01.DBO.Extreme_Slope 
geodb01.DBO.Serious_Inundation 
geodb01.DBO.Serious_SlopeRelief 
geodb01.DBO.PROV 
geodb01.DBO.png2000_prov_region 

 
○Print Maps 
The new FIMS has a simplified print template, but you can not arrange layout of the 
map. 
If you want to make and print a variety map, it will be better to create that by 
ArcMap10.  
○Edit shape and attribute of layer 
You can edit map layers by using new FIMS and ArcMap10. Editable layers are as 
follows: 

geodb01.DBO.ConcessionArea 
geodb01.DBO.Logged_NotLandUse_Current 
geodb01.DBO.LandUse_NotLogged_Current 
geodb01.DBO.Logged_LandUse_Current 
geodb01.DBO.PlanArea 
geodb01.DBO.Protected_Area 
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2.3. Access to FIMS database “geodb01” from Microsoft Access2010 

3-1. Create a new Microsoft Access 2010 file 
(1) Start Microsoft Access2010, then select File > New > Blank database. 

 
(2) After new table “Table1” will open, then close this table by clicking “×” top right 
corner of the table. Because you will import tables from the FIMS database “geodb01”. 
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3-2. Create a link to the FIMS database from Microsoft Access2010 
(1) Select External Data > ODBC Database. 

 
(2) “Get External Data” window will open, then select “Link to the data source by 
creating a linked table” and click “OK”.  

 
 

(3) “Select Data Source” window will open, then select the file data source 
“C:¥FIMS¥exe¥report.dsn”. This file describes an access point for pngfa-hq-rv3. New 
FIMS is using this file. Then click “OK”. 
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(4) “Link Table” window will open, you can select the tables that you want to use. The 
exercise of this time, select “dbo_CONCESSIONAREA”, then click “OK”. 

 
 

(5) Select  Create > Report Wizard, then you can make a report. 
Report Wizard window will open. Select Tables or Queries, then select fields which 
you want to print. 
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2.4. Query on Microsoft Access2010 using SQL 

When you want to bring data from a database, you can ask for the data using 
Structured Query Language(SQL). 
 
4-1. Preparation for using SQL 

(1) Create a new Microsoft Access 2010 file and link to “dbo_FMU”. (See 3.) 

 
(2) Select Create > Query Design.  “Show Table” window will open, then close it, and 
select View > SQL View. 
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4-2. Main structure of commonly-used tables for the reports 
The following table shows a main structure of “dbo_FMU” table.  

Field name in dbo_FMU Description 
PROVINCE Province code 
FMU FMU No 
ZONE Forest Zone code 
VEG_TYPE Vegetation type 
VEG_AREA Vegetation area (hectares) 
NO_DIST Forest type code without reference to disturbance 
VEG_TYPE_1 First Vegetation Type (in Complex) 
VOLUME Timber volume estimate for forest type per hectare 
AREA_750 Gross forest area adjusted in 1975 
VOL_75 Gross forest volume in 1975(adjusted forest area * 

timber volume) 
AREA3 Revised adjusted forest area at present 
FOREST_VOL Revised forest volume at present 
  
 
The following table shows a main structure of “dbo_CONCESSIONAREA” table. 

Field name in 
dbo_CONCESSIONAREA 

Description 

PLAN_ID ID given to the concession area of each province 
NAME Name of the concession area 

  

Write SQL statement in the area 
to retrieve data from the 
database 
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Field name in 
dbo_CONCESSIONAREA 

Description 

STATUS An existing concession area has the status 
‘Concession’. A new concession area has the status 
“Proposed”. 

PROVINCE Province code 
 
The following table shows a structure of “dbo_master_Province” table. 
You can replace a province code with a province name by using this table. (See 4.10) 

Field name in 
dbo_master_Province 

Description 

code_n Province code 
code_a Province short name 
descrip Province name 
 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
Exercise 4-2 

Add link to dbo_CONCESSIONAREA table and dbo_master_Province table. 
When the following window opens, select “code_n”. 
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Result 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
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4-3.SQL Clauses 
The following table lists the most common SQL clauses. 
SQL clause What it does 
SELECT Lists the fields that contain data of interest. 
FROM Lists the tables that contain the fields listed in the SELECT clause. 
WHERE Specifies field criteria that must be met by each record to be included 

in the results. 
ORDER BY Specifies how to sort the results. 
GROUP BY In a SQL statement that contains aggregate functions, lists fields that 

are not summarized in the SELECT clause. 
HAVING In a SQL statement that contains aggregate functions, specifies 

conditions that apply to fields that are summarized in the SELECT 
statement. 

 
4-4. SELECT and FROM statements 
SELECT and FROM statements are basic SQL clauses. 
Enter the following code: 

SELECT * 
FROM dbo_FMU 

 
Select Design > ! RUN , then you can check the result.  

 
The result will show all fields of FMU table. If you want to go back to SQL View window, 
Select View > SQL View. 
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 “SELECT” lists the fields that contain data of interest. 
 “*” means to select all fields.  
 “FROM” lists the tables that contain the fields listed in the SELECT clause. 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
Exercise 4-4 (1) 

Retrieve all fields of “dbo_master_Province” table. 
 
Result 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
 
When you want to pick up specific fields, you need to specify the field name after 
“SELECT”.  
Enter the following code: 

SELECT PROVINCE, FMU, ZONE, VEG_TYPE 
FROM dbo_FMU 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
Exercise 4-4 (2) 

Retrieve “code_n” and “descrip” of dbo_master_Province table. 
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Result 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
 
4-5. Rename the original field name to field alias 
When you want to rename column name that is displayed for any field in datasheet view, 
you can name by using “AS”.  
Enter the following code: 

SELECT PROVINCE, FMU, ZONE, VEG_TYPE AS Vegetaion 
FROM dbo_FMU 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
Exercise 4-5 

Rename the columns of the dbo_master_Province table, from “code_n” to 
“ProvinceCode”, from “code_a” to “ShortName” and from “descrip” to 
“ProvinceName” . 
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Result 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
 
4-6. Sort the results 
You can sort the result using “ORDER BY” statement. 
Enter the following code: 

SELECT PROVINCE, FMU, ZONE, VEG_TYPE 
FROM dbo_FMU 
ORDER BY PROVINCE ASC, FMU DESC 

 
 “ORDER BY” clause contains a list of the fields that you want to sort  
 “ASC” means ascending order (A to Z, 0 to 9).  
 “DESC” means descending order (Z to A, 9 to 0). 
 The default sort order is ascending order, so you can omit “ASC”.  

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
Exercise 4-6 

Retrieve “PLAN_ID”, “NAME” and “STATUS” from “dbo_CONCESSIONAREA”. 
List the concession area of "proposed" status before of "concession" status. 
List the “PLAN_ID” in ascending order. 
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Result 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
 
4-7. Limit the results (specify condition) 
When you want to use data to limit the number of records that are returned in a query, 
you can use “WHERE” statement. 
Enter the following code: 

SELECT PROVINCE, FMU, ZONE, VEG_TYPE AS Vegetation 
FROM dbo_FMU 
Where PROVINCE = 9 
ORDER BY PROVINCE ASC, FMU DESC 

 “Where” clause is set after “FROM” clause. 
 Operator 

Operator Description Example 
= equal PROVINCE=9 

VEG_TYPE=”Hm” (When Data Type of 
Field is “Text”, you need to enclose a 
value with “ double quotation” ) 

<> not equal PROVINCE<>9 
> grater than PROVINCE>9 
< less than PROVINCE<9 

The rest is omitted. 
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>= grater than or equel PROVINCE>=9 
<= Less than or equel PROVINCE<=9 

NOT Not NOT (PROVINCE =9) 
OR Or PROVINCE=9 OR PROVINCE=10 

AND And PROVINCE = 9 AND VEG_TYPE="O" 
IN In PROVINCE IN (1,2,3) 

IS NULL equal NULL PROVINCE is null 
IS NOT NULL not equal NULL PROVINCE is not null 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
Exercise 4-7 (1) 

Retrieve “PLAN_ID”, “NAME” and “STATUS” from “dbo_CONCESSIONAREA”. 
Find the concession area of the proposed status. 
List the “NAME” in ascending order. 
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Result 

 
 
Exercise 4-7 (2) 

Retrieve “PROVINCE”, “FMU” , “VEG_TYPE” and “Volume” as TimberVolume from 
“dbo_FMU”. 
Find the FMUs which have more than 30 of timber volume in Madang province. 
List the “VEG_TYPE” in ascending order, “VOLUME” in descending order. 

 

The rest is omitted. 
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Result 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
 
4-8. Aggregate function 
When you want to work with summarized data, you can use “GROUP BY” statement, 
aggregate functions (such as SUM, COUNT, AVG, MAX or MIN). 
Enter the following code: 

SELECT VEG_TYPE, COUNT(*) as Count, MAX(VOLUME) as 
MAX,MIN(VOLUME) as MIN, AVG(VOLUME) as AVG, SUM(VEG_AREA) as 
SUM_AREA 
From dbo_FMU 
GROUP BY VEG_TYPE 
ORDER BY VEG_TYPE ASC 
 

 The above statement retrieves the number of each veg_type and, highest and lowest 
volume, average of timber volume and total of forest area in each vegetation type. 

 GROUP BY clause is used in conjunction with the aggregate functions to group the 
result-set by one or more columns. 

 GROUP BY clause follows FROM clause if there is no WHERE clause.  
 GROUP BY clause lists the fields to which you do not apply an aggregate function. 
 Major aggregate functions are as follows: 

 

The rest is omitted. 
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NAME Description 
AVG( ) Calculate the average of the values in a field 
COUNT( ) Count the number of values in a field 
MAX( ) Extract the highest value in a field 
MIN( ) Extract the lowest value in a field 
SUM( ) Calculate the total of the values in a field 
 
 The following statement retrieves the number of each veg_type and, highest and 

lowest volume, average of timber volume and total of forest volume in each 
vegetation type. 

 Operator “*” for multiplication : “VOLUME*VEG_AREA” means “VOLUME” 
multiplied by “VEG_AREA”. 
 

SELECT VEG_TYPE, COUNT(*) AS Count, MAX(VOLUME) AS MAX, 
MIN(VOLUME) AS MIN, AVG(VOLUME) AS AVG, 
SUM(VOLUME*VEG_AREA) AS FOREST_VOLUME 
FROM dbo_FMU 
GROUP BY VEG_TYPE 
ORDER BY VEG_TYPE 

 
 The following statement retrieves the number of each veg_type and, highest and 

lowest timber volume, average of timber volume and total volume of forest volume 
in each province and vegetation type. 

 If you want to round the figure of aggregate result, you can use "ROUND" function. 
SELECT PROVINCE, VEG_TYPE, COUNT(*) as Count, MAX(VOLUME) as 
MAX,MIN(VOLUME) as MIN, ROUND(AVG(VOLUME),2) as AVG, 
SUM(VOLUME*VEG_AREA) as FOREST_VOLUME 
From dbo_FMU 
GROUP BY PROVINCE, VEG_TYPE 
ORDER BY PROVINCE ASC, VEG_TYPE ASC, AVG(VOLUME) ASC 
 

++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
Exercise 4-8 (1) 

Find the number of FMUs in each province. 
Reneme the Column name that shows figure of the number to “Count”.  
List province code in ascending order. 
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Result 

 
 

Exercise 4-8 (2) 
Retrieve first vegetation type (in complex) “Hm” in each province. 
Find the number of “Hm” polygons in each province. 
Find the maximum value, minimum value and average amount of “Hm”. 
Find the total area of “Hm” in each province. 
Find the total forest volume and adjusted forest volume in each province. 
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Result 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
 
4-9. Limiting aggregate values by using group criteria 
When you want to use criteria to limit the results, but the field that you want to apply 
criteria to is used in an aggregate function, you cannot use a WHERE clause.  
Instead, you can use a HAVING clause. A HAVING clause works like a WHERE clause, 
but is used for aggregated data. 
 
Enter the following code: 

SELECT PROVINCE, VEG_TYPE, COUNT(*) as Count, MAX(VOLUME) as 
MAX,MIN(VOLUME) as MIN, ROUND(AVG(VOLUME),2) as AVG, 
SUM(VEG_AREA) as SUM_AREA, SUM(VOLUME*VEG_AREA) as 
FOREST_VOLUME 
From dbo_FMU 
WHERE PROVINCE = 1 
GROUP BY PROVINCE, VEG_TYPE 
HAVING COUNT(*)>=10 
ORDER BY COUNT(*) DESC 
 

 The above statement finds if any vegetation type has more than 10 polygons in 
Western province (province code = 1).  

 A statement can have a WHERE clause and a HAVING clause — criteria for fields 
that are not used in an aggregate function go in the WHERE clause, and criteria for 
fields that are used with aggregate functions go in the HAVING clause. 
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  “WHERE” clause appears in front of “GROUP BY” clause. 
 “HAVING” clause is set after “GROUP BY” clause. 

++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
Exercise 4-9 

Retrieve first vegetation type (in complex) in Western Highlands province (province 
code=9). 
Find the total area and total adjusted area in each vegetation type. 
Find the total forest volume and adjusted forest volume in each vegetation type. 
Find the total forest volume more than 0. 
List the total forest volume in descending order. 
 
 

Result 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
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5. ADVANCED 
5.1. Combine tables 
If you want to replace province code with province name on table of result, you can 
retrieve province name from another table. 
"dbo_master_Province" table has both province code and province name. 

"code_n" field of "dbo_master_Province" table means province code. 
"descrip" field of "dbo_master_Province" table means province name. 

On the other hand, “dbo_FMU” table also has the “province” field which shows province 
code. 
"dbo_FMU" table and "dbo_master_Province" has province code as common field. 
You can combine tables by using this common field. 
By uniting "province" with "code_n", you can show province name on table of result. 
 
Enter the following code: 

SELECT F.province, P.descrip AS ProvinceName, SUM(F.veg_area) AS 
TotalArea 
FROM dbo_FMU AS F, dbo_master_Province AS P 
WHERE F.province = P.code_n 
GROUP BY F.province, P.descrip 
ORDER BY F.province; 

 
Result: 
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 The above statement, “province” column is retrieved from “dbo_FMU”, and 
“ProvinceName” column is retrieved from “dbo_master_Province”. “TotalArea” 
column is calculated using field of “dbo_FMU” 

(Regarding table structure, see 4.2) 
 “WHERE” clause shows a condition for combination. 

 

 The readability of a SELECT statement can be improved by giving a table an alias. 
A table alias can be assigned either with or without the AS keyword. 

o table_name AS table alias 
o table_name table_alias 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
Exercise 5-1 

Retrieve province code, province name and total area of first vegetation type (in 
complex) “O” and “Hm” in each province.  
Find the total area of each vegetation. 
List the province code in ascending order. 

PROVINCE TotalArea

1 9845211

2 3480065

3 2987176

Code_n descrip

1 Western

2 Gulf

3 Central

Province ToalArea Code_n descrip

1 9845211 1 Western

2 3480065 2 Gulf

3 2987176 3 Central

Province ToalArea Code_n descrip

1 9845211 1 Western

1 9845211 2 Gulf

1 9845211 3 Central

2 3480065 1 Western

2 3480065 2 Gulf

2 3480065 3 Central

3 2987176 1 Western

3 2987176 2 Gulf

3 2987176 3 Central

Extract  
WHERE province = code_n 

From dbo_FMU From dbo_master_Province 

Combine 

Result 
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Result 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
 
5.2. Nested table 
If you want to know the portion of first vegetation type(in complex) in each province, 
you need to divide the area of each first vegetation type(in complex) by the total area of 
each province. 
“dbo_FMU” table does not have the total area of each province, so you can create a 
temporary virtual table(Nested table) for the total area of each province. 
 
Enter the following code: 

SELECT PROVINCE, SUM(VEG_AREA) AS TotalArea  
FROM dbo_FMU 
GROUP BY PROVINCE 

 

The rest is omitted. 
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Result 

 
 
You need to prepare another table of result which shows the area of the area of each 
first vegetation type (in complex). 
 
Enter the following code: 

SELECT F.PROVINCE, F.Veg_Type_1, SUM(F.VEG_AREA) AS AREA 
FROM dbo_FMU AS F 
GROUP BY F.PROVINCE, F.Veg_Type_1 
ORDER BY F.PROVINCE, SUM(F.VEG_AREA) DESC; 
 

Create temporary virtual table 
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Result 

 
 
After you retrieve the area of each first vegetation type (in complex) in each province, 
you can find portion of each first vegetation type (in complex). 
 
You need to combine the above two tables. 
The following statement extracts the first vegetation type (incomplex) which accounts 
for 5% or more of the each province area. 
 
Enter the following code: 

SELECT F.PROVINCE, F.Veg_Type_1, SUM(F.VEG_AREA) AS AREA, 
Nest.TotalArea AS AreaOfProvince, 
ROUND((SUM(F.VEG_AREA)/Nest.TotalArea),2) AS PROPORTION 
FROM dbo_FMU AS F,  
( 
SELECT PROVINCE, SUM(VEG_AREA) AS TotalArea  
FROM dbo_FMU 
GROUP BY PROVINCE 
) As Nest 
WHERE F.PROVINCE=Nest.PROVINCE 
GROUP BY F.PROVINCE, F.Veg_Type_1, Nest.TotalArea 
HAVING ROUND((SUM(F.VEG_AREA)/Nest.TotalArea),2)>=0.05 

The rest is omitted. 

This table shows the area of 

each first vegetation type in 

province. 
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ORDER BY F.PROVINCE ASC, SUM(F.VEG_AREA) DESC; 
 

Result 

 
 The above statement is using two tables. 

o “dbo_FMU”, which alias name is “F” 
o Temporary virtual table, which alias name is “Nest”. 

 The virtual table (Nested table) is placed into FROM statement. 
 Operator “/” for division: “(SUM(F.VEG_AREA)/Nest.TotalArea” means total of 

“F.VEG_AREA” divided by “Nest.TotalArea”. 
 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
Exercise 5-2 

Change the last example statement.  
Limit to only the result of Madang Province. 
Extract the first vegetation type (incomplex) which accounts for 10% or more. 

The rest is omitted. 
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Result 

 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
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Answer 
 
Exercise4-4 (1) 

SELECT * 
FROM dbo_master_province; 

 
Exercise4-4 (2) 

SELECT dbo_master_Province.code_n, dbo_master_Province.descrip 
FROM dbo_master_Province; 

 
Exercise4-5 

SELECT code_n as ProvinceCode, descrip as ProvinceName 
FROM dbo_master_Province; 

 
Exercise4-6 

SELECT PLAN_ID, NAME, STATUS 
From dbo_CONCESSIONAREA 
ORDER BY Status DESC, Plan_ID ASC; 

 
Exercise4-7 (1) 

SELECT PLAN_ID, NAME, STATUS 
FROM dbo_CONCESSIONAREA 
WHERE STATUS = "PROPOSED" 
ORDER BY NAME; 

 
Exercise4-7 (2) 

SELECT PROVINCE, FMU,VEG_TYPE,VOLUME 
FROM dbo_FMU 
WHERE VOLUME>=30 AND PROVINCE=13 
ORDER BY VEG_TYPE ASC, VOLUME DESC 

 
Exercise4-8 (1) 

SELECT dbo_FMU.PROVINCE, Count(*) AS COUNT 
FROM dbo_FMU 
GROUP BY dbo_FMU.PROVINCE 
ORDER BY dbo_FMU.PROVINCE; 
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Exercise4-8 (2) 

SELECT Province, Veg_Type_1, Count(*) AS Count, Max(Volume) AS Max, 
Min(Volume) AS Min, Round(Avg(Volume),2) AS Avg, SUM(VEG_AREA) AS AREA, 
SUM(Volume*VEG_AREA) AS FOREST_VOLUME,SUM(Volume*AREA3) AS 
AdjFOREST_VOLUME 
FROM dbo_Fmu 
WHERE Veg_type_1="Hm" 
GROUP BY Province, Veg_Type_1 
ORDER BY Province, Veg_Type_1; 

 
Exercise4-9 

SELECT PROVINCE, VEG_TYPE_1 AS FirstVegetaionType, SUM(VEG_AREA) AS 
AREA, SUM(AREA3) AS ADJUSTED_AREA, SUM(Volume*VEG_AREA) AS 
FOREST_VOLUME, SUM(Volume*AREA3) AS AdjFOREST_VOLUME 
FROM dbo_FMU 
WHERE PROVINCE = 9 
GROUP BY PROVINCE, VEG_TYPE_1 
HAVING SUM(VOLUME*VEG_AREA) > 0 
ORDER BY SUM(VOLUME*VEG_AREA) DESC; 
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Exercise5-1 
SELECT F.province AS ProvinceCode, P.descrip AS ProvinceName, F.VEG_TYPE_1 
AS Vegetation, Sum(F.VEG_AREA) AS TotalArea 
FROM dbo_FMU AS F, dbo_master_Province AS P 
WHERE (F.province=P.code_n) AND ((F.VEG_TYPE_1)="O" OR 
(F.VEG_TYPE_1)="Hm") 
GROUP BY F.province, P.descrip, F.VEG_TYPE_1 
ORDER BY F.province ASC; 

 
Exercise5-2 

SELECT F.PROVINCE, F.Veg_Type_1, SUM(F.VEG_AREA) AS AREA, 
Nest.TotalArea AS AreaOfProvince, 
ROUND((SUM(F.VEG_AREA)/Nest.TotalArea),2) AS PROPORTION 
FROM dbo_FMU AS F, (SELECT PROVINCE, SUM(VEG_AREA) AS TotalArea 
FROM dbo_FMU GROUP BY PROVINCE)  AS Nest 
WHERE F.PROVINCE=Nest.PROVINCE AND F.PROVINCE=13 
GROUP BY F.PROVINCE, F.Veg_Type_1, Nest.TotalArea 
HAVING ROUND((SUM(F.VEG_AREA)/Nest.TotalArea),2)>=0.1 
ORDER BY F.PROVINCE, SUM(F.VEG_AREA) DESC; 
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3. Maintenance of the Forest Resource Database 

3.1.  Backup and Restoring 

FIPS data is stored on an SQL Server, so backup is carried out in accordance with normal SQL 
Server backup procedures.  
 

3.1.1. Backup setting procedure 

Backup of data is automated by the following procedure. 
 
(1) Prepare the backup destination 
 Prepare a hard disk for storing the backup files. 
 
(2) Prepare a backup batch file 
 Prepare a batch file for performing the backup. 
 In the following, the SQLServer instance is “PNG-SERVER”, the login user is “sa”, the login 
password is “pngf@123”. The DBs to be stored are “geodb01” and “FIPS”, the storage 
destination is “E:¥DB_BACKUP”, and the criterion for deleting files is “files that are 30 days 
old or more”. 
 

echo off 
rem 
rem SQL Server backup 
rem 
 
rem Get Date 
set TODAY=%date:~-10,2%%date:~-7,2%%date:~-4,4% 
rem echo %TODAY% 
 
rem BackUp Main Process 
echo Start Backup..... 
sqlcmd –U sa –P pngf@123 -S PNG-SERVER -Q "BACKUP DATABASE geodb01 TO DISK 
= N'E:¥DB_BACKUP¥%TODAY%_geodb01.bak' WITH INIT" 
sqlcmd –U sa –P pngf@123 -S PNG-SERVER -Q "BACKUP DATABASE FIPS TO DISK = 
N'E:¥DB_BACKUP¥%TODAY%_FIPS.bak' WITH INIT" 
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rem Delete Old Backup 

echo Delete Old Backup… 
forfiles /P E:¥DB_BACKUP /S /D -30 /C "cmd /c del /F /S /Q e:¥DB_BACKUP¥@file" 

 
The login user and password for SQL Server need to be included in the batch file. Therefore, 

it is desirable for security that the batch file is in a location that normal users cannot see it. 
 
(3) Prepare backup task 
 A Task is registered in the Task Scheduler in order to perform periodic backups and delete old 
backup files. 
 Start up Server Manager, and select Configuration->Task Scheduler->Task Scheduler Library 
from the tree on the left. 
 Then, select Create Basic Task from Actions. 
 

 
Figure 3-1 Task Scheduler Library 



 -65-

Create Basic Task Wizard opens, so enter the Task name in Name, and click the Next button. 

 

Figure 3-2 Create Basic Task Wizard (1) 
 

Select the interval for performing the Task, and click the Next button. 

 
Figure 3-3 Create Basic Task Wizard (2) 
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Specify the timing (date and time) for performing the Task. 
Also, specify the interval for performing the Task, and click the Next button.  

 
Figure 3-4 Create Basic Task Wizard (3) 

 
Select Start a program, and enter the path to the prepared batch file (it is not necessary to set 

arguments, etc.). Then, click the Next button. 

 

Figure 3-5 Create Basic Task Wizard (4) 
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Figure 3-6 Create Basic Task Wizard (5) 

 
 Finally, confirm the settings, and click the Finish button. 

 
図 3-7  Create Basic Task Wizard (6) 

 



 -68-

After preparing the Task, right click the prepared Task with the mouse and select Properties. 
Then select “Run whether user is logged on or not” from the Security options of the General tab, 
then click the OK button. (Input of the password is required, so input the password.) 

 

Figure 3-8 Task Properties 
 
This completes the backup settings. 
 

3.1.2. Restore procedure 

Restoring files that have been backed up should be performed for DBs with the same name as 
during backup. 
 (If the GeoDatabase backup file is restored to a DB with a different name, it may not operate 
correctly.) 
Restoring a database is performed by the following procedure. 
 
(1) Stop and restart services 
 Stop the ArcSDE service, and restart SQL Server services. 
 Restoring SQL Server will not terminate normally if there is access to the database (session), 
so access (the session) is forcibly severed by restarting the SQL Server service, etc. 
 
a. Start Server Manager, and select Configuration->Services from the tree on the left. 
 
 
b. From the list, select ArcSde Service(***), and Stop it. 
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Figure 3-9 Services 
 
c. Open the Start menu, and select All Program->Microsoft SQL Server 2008->Configuration 
Tools->SQL Server Configuration Manager. 
d. From SQL Server Service, right click SQL Server (***) with the mouse, and select Restart. 
 

 
Figure 3-10 SQL Server Configuration Manager 

 
(2) Restore the DB 
 
a. Start SQL Server Management Studio, right click the DB whose data is to be restored using 
the mouse, and select Tasks->Restore->Database. 
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Figure 3-11 SQL Server Management Studio 

 
b. In the General menu, select [From device] from Source for restore, and select the backed up 
DB file. Then, enter a check in the list. 

 
Figure 3-12 Restore Menu (General) 

 
c. Select Options, and select [Overwrite the existing database]. 
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Figure 3-13 Restore Menu (Options) 
 
d. Click the OK button, and execute the restore. 
 

※ If the database is in use (if a session remains) when the operation in (1) is performed, the 
restore will fail with an error. In this case, execute the sp_who command in SQL Server 
Management Studio to check the session. 
Search for the DB session whose dbname is the target of the restore, and delete the session 
by executing the kill [spid] command so that restore can be carried out. 
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Figure 3-14 sp_who Command 

 
(3) Restart the service 
 
a. Start Server Manager, and select Configuration->Services from the tree on the left. 
 
b. From the list, select ArcSde Service(***), and Start it. 
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3.2. Adding and deleting FIMS users 

This screen is displayed by clicking the User Management button in the Admin screen. 

 

1. Province： Click to go to the Provinces screen and display the list of provinces. 

EXIT： Click to exit the system. 

2. Layer Management： Click to go to the Layer Management screen. 

User Management： Click to go to theUser Management screen. 

FIPS Data Import： Click to go to the FIPS Data Import screen.. 

3. Displays user information. 

Edit： Click to go to the Edit User screen. 

Delete： Click to delete user information. 

Add： Click to go to the Add User screen. 
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3.3. Adding and deleting FIPS users 

You can manage the accounts of FIPS users. User management requires the administrative 
authority or the developer authority to run, and the user with general authority cannot use this 
option. 
 
The user with administrative authority can manage only the account of users with administrative 
authority or general authority. The developer authority is superior to the administrative 
authority; therefore the user with administrative authority cannot add / edit the account of user 
with developer authority. 
 
The user with developer authority can manage all the accounts of users. 
 

3.3.1. Logging in with administrative authority or developer authority 

Login with administrative authority or developer authority. 
The Microsoft Access menu is displayed. 
 

3.3.2. Access to tables for user management 

Double click “F_USER” in Tables on the left side of the screen, and the user management table 
opens. 
 
 
 

 
 

Double Click “F_USER” 
in Tables 
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3.3.3. Adding or modifying users 

To add or modify a user, enter “USER_NAME”, “PASSWORD”, “AUTHORITY”. 
 
 

Field Name Description Points to note 

USER_NAME User name 50 text characters or less 

PASSWORD Password 50 text characters or less 

AUTHORITY User’s authority 

Enter either 1, 2, or 3 
1 : Developer authority 
2 : Administrative authority 
3 : General authority 

 

 

 

3.3.4. Deleting a user 

To delete a user, select the user to be deleted, and right click. Select “Delete” from the menu. 
 



 

 

Forest Resource Database specification 
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1  Data content and structure of FIMS Database 
 

1.1  FIMS application schema 

 

<<Polygon>>
F MU

<<Field>>
+ province  :esriFieldTypeDouble
+ FMU  :esriFieldTypeDouble
+ zone  :esriFieldTypeDouble
+ map_no  :esriFieldTypeDouble
+ map_id  :esriFieldTypeDouble
+ veg_type  :esriFieldTypeString
+ veg_area  :esriFieldTypeDouble
+ slope  :esriFieldTypeDouble
+ altitude  :esriFieldTypeDouble
+ karst  :esriFieldTypeDouble
+ inundation  :esriFieldTypeDouble
+ mangrove  :esriFieldTypeDouble
+ sloperelie  :esriFieldTypeDouble
+ inundati0  :esriFieldTypeDouble
+ area  :esriFieldTypeDouble
+ area0  :esriFieldTypeDouble
+ extreme  :esriFieldTypeDouble
+ serious  :esriFieldTypeDouble
+ area1  :esriFieldTypeDouble
+ ext_sl  :esriFieldTypeDouble
+ ext_alt  :esriFieldTypeDouble
+ ext_kst  :esriFieldTypeDouble
+ ext_in  :esriFieldTypeDouble
+ ext_man  :esriFieldTypeDouble
+ ser_sl  :esriFieldTypeDouble
+ ser_in  :esriFieldTypeDouble
+ type  :esriFieldTypeSmallInteger
+ no_dist  :esriFieldTypeString
+ veg_type_1  :esriFieldTypeString
+ veg_type_2  :esriFieldTypeString
+ veg_type_3  :esriFieldTypeString
+ type_base  :esriFieldTypeString
+ area_75  :esriFieldTypeDouble
+ index_  :esriFieldTypeDouble
+ percent_  :esriFieldTypeDouble
+ area_750  :esriFieldTypeDouble
+ volume  :esriFieldTypeDouble
+ vol_75  :esriFieldTypeDouble
+ to96  :esriFieldTypeDouble
+ to960  :esriFieldTypeDouble
+ to961  :esriFieldTypeDouble
+ ext_sl0  :esriFieldTypeDouble
+ ext_alt0  :esriFieldTypeDouble
+ ext_kst0  :esriFieldTypeDouble
+ ext_in0  :esriFieldTypeDouble
+ ext_man0  :esriFieldTypeDouble
+ ser_sl0  :esriFieldTypeDouble
+ ser_in0  :esriFieldTypeDouble
+ current_  :esriFieldTypeDouble
+ current0  :esriFieldTypeDouble
+ current1  :esriFieldTypeDouble
+ current2  :esriFieldTypeDouble
+ ext_sl1  :esriFieldTypeDouble
+ ext_alt1  :esriFieldTypeDouble
+ ext_kst1  :esriFieldTypeDouble
+ ext_in1  :esriFieldTypeDouble
+ ext_man1  :esriFieldTypeDouble
+ ser_sl1  :esriFieldTypeDouble
+ ser_in1  :esriFieldTypeDouble
+ area2  :esriFieldTypeDouble
+ area3  :esriFieldTypeDouble
+ forest_vol  :esriFieldTypeDouble

<<ObjectClass>>
Ct rl_* _Concess ion_FMU

<<Field>>
+ province  :esriFieldTypeInteger
+ FMU  :esriFieldTypeInteger
+ Zone  :esriFieldTypeInteger
+ Map_No  :esriFieldTypeDouble
+ Map_id  :esriFieldTypeDouble
+ Veg_Type  :esriFieldTypeString
+ Veg_Area  :esriFieldTypeDouble
+ Extreme_Slope  :esriFieldTypeDouble
+ Extreme_Altitude  :esriFieldTypeDouble
+ Extreme_Karst  :esriFieldTypeDouble
+ Extreme_Inundation  :esriFieldTypeDouble
+ Extreme_Mangrove  :esriFieldTypeDouble
+ Serious_SlopeRelief  :esriFieldTypeDouble
+ Serious_Inundation  :esriFieldTypeDouble
+ Extreme_Constraints_Area  :esriFieldTypeDouble
+ Serious_Constraints_Area  :esriFieldTypeDouble
+ Prop_Extreme  :esriFieldTypeDouble
+ Prop_Serious  :esriFieldTypeDouble
+ Protected_Area  :esriFieldTypeDouble
+ Protected_Ext_Sl  :esriFieldTypeDouble
+ Protected_Ext_Alt  :esriFieldTypeDouble
+ Protected_Ext_Kst  :esriFieldTypeDouble
+ Protected_Ext_In  :esriFieldTypeDouble
+ Protected_Ext_Man  :esriFieldTypeString
+ Protected_Ser_Sl  :esriFieldTypeDouble
+ Protected_Ser_In  :esriFieldTypeDouble
+ Fragile_Forest_Type  :esriFieldTypeInteger
+ Forest_Type_No_Dist  :esriFieldTypeString
+ Forest_Type_Base  :esriFieldTypeString
+ Gross_Forest_Area_75  :esriFieldTypeDouble
+ Disturbance_Index  :esriFieldTypeDouble
+ Complext_Percent  :esriFieldTypeDouble
+ Adjusted_Forest_Area_75  :esriFieldTypeDouble
+ Timber_Volume  :esriFieldTypeDouble
+ Gross_Freost_Vol_75  :esriFieldTypeDouble
+ Logged_NotLandUse_75to96  :esriFieldTypeDouble
+ Logged_LandUse_75to96  :esriFieldTypeDouble
+ LandUse_NotLogged_75to96  :esriFieldTypeDouble
+ LogAndLUse_75to96_Ext_Sl  :esriFieldTypeDouble
+ LogAndLUse_75to96_Ext_Alt  :esriFieldTypeDouble
+ LogAndLUse_75to96_Ext_Kst  :esriFieldTypeDouble
+ LogAndLUse_75to96_Ext_In  :esriFieldTypeDouble
+ LogAndLUse_75to96_Ext_Man  :esriFieldTypeDouble
+ LogAndLUse_75to96_Ser_Sl  :esriFieldTypeDouble
+ LogAndLUse_75to96_Ser_In  :esriFieldTypeDouble
+ Logged_NotLandUse_Current  :esriFieldTypeDouble
+ Logged_LandUse_Current  :esriFieldTypeDouble
+ LandUse_NotLogged_Current  :esriFieldTypeDouble
+ LogAndLUse_Current  :esriFieldTypeDouble
+ LogAndLUse_Current_Ext_Sl  :esriFieldTypeDouble
+ LogAndLUse_Current_Ext_Alt  :esriFieldTypeDouble
+ LogAndLUse_Current_Ext_Kst  :esriFieldTypeDouble
+ LogAndLUse_Current_Ext_In  :esriFieldTypeDouble
+ LogAndLUse_Current_Ext_Man  :esriFieldTypeDouble
+ LogAndLUse_Current_Ser_Sl  :esriFieldTypeDouble
+ LogAndLUse_Current_Ser_In  :esriFieldTypeDouble
+ Rev_Gross_Forest_Area  :esriFieldTypeDouble
+ Rev_Adjusted_Forest_Area  :esriFieldTypeDouble
+ Rev_Gross_Forest_Vol  :esriFieldTypeDouble
+ plan_id  :esriFieldTypeInteger
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<<Polygon>>
Conces s ionArea

<<Field>>
+ plan_id  :esriFieldTypeDouble
+ name  :esriFieldTypeString
+ area  :esriFieldTypeDouble
+ purchase  :esriFieldTypeDate
+ exp  :esriFieldTypeDate
+ constype  :esriFieldTypeString
+ status  :esriFieldTypeString
+ scale  :esriFieldTypeString
+ province  :esriFieldTypeDouble

<<Polygon>>
Ex t reme_Alt it ude

<<Field>>
+ province  :esriFieldTypeDouble
+ provname  :esriFieldTypeString
+ area  :esriFieldTypeDouble
+ altitude  :esriFieldTypeString

<<Polygon>>
Ex t reme_Inunda t ion

<<Field>>
+ province  :esriFieldTypeDouble
+ provname  :esriFieldTypeString
+ area  :esriFieldTypeDouble
+ inund  :esriFieldTypeString
+ iextent  :esriFieldTypeSmallInteger

<<Polygon>>
Ex t reme_Kars t

<<Field>>
+ province  :esriFieldTypeDouble
+ provname  :esriFieldTypeString
+ area  :esriFieldTypeDouble
+ landform  :esriFieldTypeSmallInteger

<<Polygon>>
Ex t reme_Slope

<<Field>>
+ slope1  :esriFieldTypeDouble
+ province  :esriFieldTypeDouble
+ provname  :esriFieldTypeString
+ area  :esriFieldTypeDouble

<<Polygon>>
Ex t reme_Mang rove

<<Field>>
+ province  :esriFieldTypeDouble
+ vegtype  :esriFieldTypeString
+ area  :esriFieldTypeDouble

<<Polygon>>
Serious _ Inunda t ion

<<Field>>
+ province  :esriFieldTypeDouble
+ provname  :esriFieldTypeString
+ area  :esriFieldTypeDouble
+ inund  :esriFieldTypeString
+ iextent  :esriFieldTypeSmallInteger

<<Polygon>>
Serious _SlopeRel ief

<<Field>>
+ province  :esriFieldTypeDouble
+ provname  :esriFieldTypeString
+ area  :esriFieldTypeDouble
+ slope1  :esriFieldTypeSmallInteger
+ slope2  :esriFieldTypeString
+ relief  :esriFieldTypeString

<<Polyline>>
F _St rip _Line

<<Field>>
+ vegetation  :esriFieldTypeString
+ plan_id  :esriFieldTypeInteger
+ survey_number  :esriFieldTypeString
+ survey_name  :esriFieldTypeString
+ survey_date  :esriFieldTypeDate
+ block_number  :esriFieldTypeString
+ strip  :esriFieldTypeString
+ strip_volume  :esriFieldTypeDouble
+ strip_volume_per_ha  :esriFieldTypeDouble
+ start_lat  :esriFieldTypeDouble
+ start_lon  :esriFieldTypeDouble
+ end_lat  :esriFieldTypeDouble
+ end_lon  :esriFieldTypeDouble
+ last_update  :esriFieldTypeDate
+ loi_flag  :esriFieldTypeString
+ slope_min  :esriFieldTypeDouble
+ slope_max  :esriFieldTypeDouble
+ elevation_min  :esriFieldTypeDouble
+ elevation_max  :esriFieldTypeDouble

<<Polygon>>
PlanArea

<<Field>>
+ province  :esriFieldTypeDouble
+ area  :esriFieldTypeDouble
+ type  :esriFieldTypeString
+ PRJHARVOL  :esriFieldTypeDouble
+ plan_id  :esriFieldTypeDouble
+ year  :esriFieldTypeString
+ name  :esriFieldTypeString
+ area2  :esriFieldTypeDouble
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<<Polygon>>
Prot ect ed_Area

<<Field>>
+ protected_id  :esriFieldTypeDouble
+ name  :esriFieldTypeString
+ type  :esriFieldTypeString
+ gaz_date  :esriFieldTypeString
+ province  :esriFieldTypeString
+ location  :esriFieldTypeString
+ tenure  :esriFieldTypeString
+ area  :esriFieldTypeDouble
+ altitude  :esriFieldTypeString
+ logitude  :esriFieldTypeString
+ latitude  :esriFieldTypeString

<<Polygon>>
LandUse_NotLogg ed_Current

<<Field>>
+ province  :esriFieldTypeDouble
+ area  :esriFieldTypeDouble
+ area2  :esriFieldTypeDouble
+ type  :esriFieldTypeString
+ acharvol  :esriFieldTypeDouble
+ plan_id  :esriFieldTypeDouble
+ year  :esriFieldTypeString
+ name  :esriFieldTypeString

<<Polygon>>
Log ged_And_LUse_Current

<<Field>>
+ province  :esriFieldTypeDouble
+ area  :esriFieldTypeDouble

<<Polygon>>
Log ged_LandUse_Current

<<Field>>
+ province  :esriFieldTypeDouble
+ area  :esriFieldTypeDouble
+ area2  :esriFieldTypeDouble
+ type  :esriFieldTypeString
+ acharvol  :esriFieldTypeDouble
+ plan_id  :esriFieldTypeDouble
+ year  :esriFieldTypeString
+ name  :esriFieldTypeString

<<Polygon>>
Log ged_Not LandUse_Current

<<Field>>
+ province  :esriFieldTypeDouble
+ area  :esriFieldTypeDouble
+ area2  :esriFieldTypeDouble
+ type  :esriFieldTypeString
+ acharvol  :esriFieldTypeDouble
+ plan_id  :esriFieldTypeDouble
+ year  :esriFieldTypeString
+ name  :esriFieldTypeString

<<Polygon>>
LandUse_NotLog ged_7596

<<Field>>
+ privnce  :esriFieldTypeDouble
+ area  :esriFieldTypeDouble

<<Polygon>>
Log ged_And_LUse_7596

<<Field>>
+ area  :esriFieldTypeDouble
+ privnce  :esriFieldTypeDouble

<<Polygon>>
Log ged_LandUse_7596

<<Field>>
+ province  :esriFieldTypeDouble
+ area  :esriFieldTypeDouble

<<Polygon>>
Logg ed_NotLandUse_7596

<<Field>>
+ province  :esriFieldTypeDouble
+ area  :esriFieldTypeDouble

<<Polygon>>
PROV

<<Field>>
+ code  :esriFieldTypeDouble
+ province  :esriFieldTypeString

<<Polygon>>
LandUse_NotLogg ed_Current _Merge

<<Field>>
+ province  :esriFieldTypeDouble
+ area  :esriFieldTypeDouble

<<Polygon>>
Log ged_LandUse_Current _Merge

<<Field>>
+ province  :esriFieldTypeDouble
+ area  :esriFieldTypeDouble

<<Polygon>>
Logg ed_NotLandUse_Current _Merge

<<Field>>
+ province  :esriFieldTypeDouble
+ area  :esriFieldTypeDouble
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<<Polygon>>
TmpLayer

<<Field>>
+ province  :esriFieldTypeString
+ fmu  :esriFieldTypeDouble
+ zone  :esriFieldTypeDouble
+ plan_id  :esriFieldTypeDouble

<<Polygon>>
TmpLayer2

<<Field>>
+ province  :esriFieldTypeString
+ fmu  :esriFieldTypeDouble
+ zone  :esriFieldTypeDouble
+ plan_id  :esriFieldTypeDouble
+ KEY_ID  :esriFieldTypeString

<<Polygon>>
Tmpinfo

<<Field>>
+ province  :esriFieldTypeString
+ FMU  :esriFieldTypeDouble
+ zone  :esriFieldTypeDouble
+ map_no  :esriFieldTypeDouble
+ map_id  :esriFieldTypeDouble
+ veg_type  :esriFieldTypeString
+ veg_area  :esriFieldTypeDouble
+ slope  :esriFieldTypeDouble
+ altitude  :esriFieldTypeDouble
+ karst  :esriFieldTypeDouble
+ inundation  :esriFieldTypeDouble
+ mangrove  :esriFieldTypeDouble
+ sloperelie  :esriFieldTypeDouble
+ inundati0  :esriFieldTypeDouble
+ area  :esriFieldTypeDouble
+ area0  :esriFieldTypeDouble
+ extreme  :esriFieldTypeDouble
+ serious  :esriFieldTypeDouble
+ area1  :esriFieldTypeDouble
+ ext_sl  :esriFieldTypeDouble
+ ext_alt  :esriFieldTypeDouble
+ ext_kst  :esriFieldTypeDouble
+ ext_in  :esriFieldTypeDouble
+ ext_man  :esriFieldTypeDouble
+ ser_sl  :esriFieldTypeDouble
+ ser_in  :esriFieldTypeDouble
+ type  :esriFieldTypeSmallInteger
+ no_dist  :esriFieldTypeString
+ veg_type_1  :esriFieldTypeString
+ veg_type_2  :esriFieldTypeString
+ veg_type_3  :esriFieldTypeString
+ type_base  :esriFieldTypeString
+ index_  :esriFieldTypeDouble
+ percent_  :esriFieldTypeDouble
+ area_75  :esriFieldTypeDouble
+ area_750  :esriFieldTypeDouble
+ volume  :esriFieldTypeDouble
+ vol_75  :esriFieldTypeDouble
+ to96  :esriFieldTypeDouble
+ to960  :esriFieldTypeDouble
+ to961  :esriFieldTypeDouble
+ ext_sl0  :esriFieldTypeDouble
+ ext_alt0  :esriFieldTypeDouble
+ ext_kst0  :esriFieldTypeDouble
+ ext_in0  :esriFieldTypeDouble
+ ext_man0  :esriFieldTypeDouble
+ ser_sl0  :esriFieldTypeDouble
+ ser_in0  :esriFieldTypeDouble
+ current_  :esriFieldTypeDouble
+ current0  :esriFieldTypeDouble
+ current1  :esriFieldTypeDouble
+ current2  :esriFieldTypeDouble
+ ext_sl1  :esriFieldTypeDouble
+ ext_alt1  :esriFieldTypeDouble
+ ext_kst1  :esriFieldTypeDouble
+ ext_in1  :esriFieldTypeDouble
+ ext_man1  :esriFieldTypeDouble
+ ser_sl1  :esriFieldTypeDouble
+ ser_in1  :esriFieldTypeDouble
+ area2  :esriFieldTypeDouble
+ area3  :esriFieldTypeDouble
+ forest_vol  :esriFieldTypeDouble
+ plan_id  :esriFieldTypeString
+ name  :esriFieldTypeString
+ constype  :esriFieldTypeString
+ status  :esriFieldTypeString
+ scale  :esriFieldTypeString
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<<ObjectClass>>
mas t er_Zones

+ Zone  :int
+ Name  :string
+ Description  :string

<<ObjectClass>>
mas t er_Spec ies

+ Province  :int
+ Zone  :int
+ Species  :string
+ D  :double
+ D/Fsw  :double
+ D/W  :double
+ FriK  :double
+ FriK/Ps  :double
+ FriTb  :double
+ FriTB/Wri  :double
+ Fsw  :double
+ FswC  :double
+ FswTb  :double
+ Hl  :double
+ Hl/Hm  :double
+ HlN  :double
+ Hm  :double
+ Hm/D  :double
+ Hm/D/Fsw  :double
+ Hm/Fsw  :double
+ Hm/Fsw/Wsw  :double
+ Hm/Hs  :double
+ Hm/Hs/Fsw  :double
+ Hm/HsN  :double
+ Hm/Sc  :double
+ HmAr  :double
+ Hmd  :double
+ Hme/Hm  :double
+ Hm/HmAr  :double
+ Hm/Ps  :double
+ Hs  :double
+ HsAr  :double
+ Hs/Fsw  :double
+ Hs/Hm  :double
+ Hs/Ps  :double
+ Hs/Sa  :double
+ Hse  :double
+ L  :double
+ L/Lc  :double
+ L/LN  :double
+ L/Ls  :double
+ LAr  :double
+ Lc  :double
+ LN  :double
+ LN/LsN  :double
+ Ls  :double
+ LsAr  :double
+ Ls/L  :double
+ Ls/Lc  :double
+ LsN  :double
+ LsN/LN  :double
+ M  :double
+ Pl  :double
+ Pl/FriK  :double
+ Pl/Fsw  :double
+ Pl/Hm  :double
+ Po  :double
+ Po/FriK  :double
+ Po/Fsw  :double
+ Po/FswTb  :double
+ Po/Hs  :double
+ Po/Pl  :double
+ Po/Wsw  :double
+ Ps  :double
+ Ps/FriK  :double
+ W  :double

<<ObjectClass>>
mas t er_Sus cept ib leVegTypes

+ Province  :int
+ FMU  :int
+ VegType  :string
+ SusceptibleType  :string

<<ObjectClass>>
ct rl _TimberVolume

+ Province  :int
+ Zone  :int
+ VegType  :string
+ Vol/ha  :double
+ OriginalVol/ha  :double
+ Comments  :string

<<ObjectClass>>
mas t er_VegTypes

+ VegType  :string
+ Group  :string
+ Description  :string
+ Merchantable  :int

<<ObjectClass>>
mas t er_Report

+ Description  :string
+ ReportName  :string
+ ReportType  :int
+ Group  :int
+ Priority  :int

<<ObjectClass>>
mas t er_Prov ince

+ CODE_N  :int
+ CODE_A  :string
+ DESCRIP  :string

<<ObjectClass>>
mas t er_user

+ username  :string
+ password  :string
+ authority  :int

<<ObjectClass>>
mas t er_Da t abas e

+ Database  :string
+ Last_Update  :date/time
+ Del  :int

<<ObjectClass>>
mas t er_TmpReport

+ TmpReportName  :string
+ sysdate  :date/time
+ MachineName  :string
+ DeleteFlag  :int

<<ObjectClass>>
mas t er_Logg edOverType

+ id  :int
+ name  :string

<<ObjectClass>>
F _SURVEY_SUMMARY

+ plan_id  :int
+ SURVEY_NUMBER  :string
+ SURVEY_NAME  :string
+ ADJ_NET_FOREST_AREA  :double
+ VOL10_PER_HA  :double
+ PVOL_PER_HA  :double
+ SVOL_PER_HA  :double
+ TOTALVOL_PER_HA  :double
+ MVOL_PER_HA  :double
+ VOL10_GRP_PER_HA  :double
+ PVOL_GRP_PER_HA  :double
+ SVOL_GRP_PER_HA  :double
+ TOTALVOL_GRP_PER_HA  :double
+ MVOL_GRP_PER_HA  :double
+ LAST_UPDATE  :date/time
+ FIMS_FLAG  :boolean

<<ObjectClass>>
ct rl _Las tCa lcla t ionDa t e

+ Province  :int
+ ConcessionFlag  :int
+ CalcDate  :date/time

<<ObjectClass>>
concess ionF i le

+ id  :int
+ plan_id  :int
+ filename  :string
+ fdata  :binary

<<ObjectClass>>
mas t er_PlanAreaType

+ id  :int
+ name  :string
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1.2  Documentation of FIMS application schema 

 

1.2.1  FMU  

Forest Mapping Unit(FMU). The FMU is the basic mapping unit. 

An FMU is an area of forest or other vegetation mapped as a polygon during the 

1:100,000 mapping process. 

Each FMU is assigned a code describing the vegetation/forest type.  A total of 58 forest 

and other vegetation types are distinguished, and of these 35 are forest types.  A further 

four types deal with land use, urban areas, bare areas and lakes. FMU numbering 

commences with 1 for each Province. 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code 

 Value Domain 
CODE_N value of master_Province 

 

FMU：esriFieldTypeDouble 

FMU 

 Value Domain 
Sequence number from 1 in each province 

 

Zone：esriFieldTypeDouble 

Forest Zone code 

 Value Domain 
Zone number of master_Zone 

 

Map_No：esriFieldTypeDouble 

Original map number from 1:100,000 sheets 

 

Map_id：esriFieldTypeDouble 
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1:100,000 sheet id 

 

Veg_Type：esriFieldTypeString 

Vegetation type 

 

 

Veg_Area：esriFieldTypeDouble 

Vegetation area (hectares) 

 

Slope：esriFieldTypeDouble 

Extreme physical limitations - slope (ha) - derived from PNGRIS overlay slope1> 

30 degrees (slope1=6) 

 

Altitude：esriFieldTypeDouble 

Extreme physical limitations - altitude (ha) - derived from PNGRIS overlay 

altitude>2,400m (altitude=7 or 8) (Note: Extreme slope takes precedence) 

 

Karst：esriFieldTypeDouble 

Extreme physical limitations - karst (ha) - derived from PNGRIS overlay landform 

polygonal karst (landform=55) 

 

Inundation：esriFieldTypeDouble 

Extreme physical limitations - inundation (ha) - derived from PNGRIS overlay 

permanent or near permanent inundation > 80% of area (inund=5 or 6, iextent=4) 

 

Mangrove：esriFieldTypeDouble 

Extreme physical limitations - mangrove (ha) - derived from FIM vegetation type 

of Mangrove (Veg_Type='M') 

 

SlopeRelief：esriFieldTypeDouble 

Serious physical limitations - slope and relief (ha) - derived from PNGRIS overlay 

slope1=20-30 degrees, slope2=0 or 30 degrees (slope2=0 or 6), very high or high 

relief (relief=4,5) 

 

Inundati0：esriFieldTypeDouble 

Serious physical limitations - inundation (ha) - derived from PNGRIS overlay 
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permanent or near permanent inundation 50- 80% of area (inund=5 or 6, 

iextent=3) 

 

Area：esriFieldTypeDouble 

Total of extreme constraint area 

 

Area0：esriFieldTypeDouble 

Total of serious constraint area 

 

Extreme：esriFieldTypeDouble 

Proportion of FMU in extreme constraint area 

 

Serious：esriFieldTypeDouble 

Proportion of FMU in serious constraint area 

 

Area1：esriFieldTypeDouble 

Protected area (DEC layer) in FMU 

 

Ext_Sl：esriFieldTypeDouble 

Protected area (DEC layer) in extreme slope area 

 

Ext_Alt：esriFieldTypeDouble 

Protected area (DEC layer) in extreme altitude area 

 

Ext_Kst：esriFieldTypeDouble 

Protected area (DEC layer) in extreme karst area 

 

Ext_In：esriFieldTypeDouble 

Protected area (DEC layer) in extreme inundation area 

 

Ext_Man：esriFieldTypeDouble 

Protected area (DEC layer) in extreme mangrove area 

 

Ser_Sl：esriFieldTypeDouble 

Protected area (DEC layer) in serious slope area 
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Ser_In：esriFieldTypeDouble 

Protected area (DEC layer) in serious inundation area 

 

Type：esriFieldTypeInteger 

Fragile forest type flag (DEC) 

 

No_Dist：esriFieldTypeString 

Forest type code without reference to disturbance 

 

VEG_TYPE_1：esriFieldTypeString 

Forest type code 1 

 

VEG_TYPE_2：esriFieldTypeString 

Forest type code 2 

 

VEG_TYPE_3：esriFieldTypeString 

Forest type code 3 

 

Type_Base：esriFieldTypeString 

Forest type code without reference to disturbance or complex 

 

Area_75：esriFieldTypeDouble 

Gross forest area in 1975 

 

Index_：esriFieldTypeDouble 

Level of disturbance (eg. 9 = 90% undisturbed) 

 

Percent_：esriFieldTypeDouble 

Perecentage of vegetation type complex that is forest 

 

Area_750：esriFieldTypeDouble 

Gross forest area adjusted for disturbance and complex 

 

Volume：esriFieldTypeDouble 

Timber volume estimate for forest type 
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Vol_75：esriFieldTypeDouble 

Gross forest volume in 1975 (adjusted forest area * timber volume) 

 

to96：esriFieldTypeDouble 

Area logged but not converted to land use - 1975 to 1996 

 

to960：esriFieldTypeDouble 

Area logged and converted to land use - 1975 to 1996 

 

to961：esriFieldTypeDouble 

Area land use not logged (cleared) and converted to land use - 1975 to 1996 

 

Ext_Sl0：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme slope constraint area 

 

Ext_Alt0：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme altitude constraint area 

 

Ext_Kst0：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme karst constraint area 

 

Ext_In0：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme inundation constraint 

area 

 

Ext_Man0：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme mangrove constraint 

area 

 

Ser_Sl0：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in serious slope/relief constraint 

area 

 

Ser_In0：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in serious inundation constraint area 
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Current_：esriFieldTypeDouble 

Area logged but not converted to land use - current 

 

Current0：esriFieldTypeDouble 

Area logged and converted to land use - current 

 

Current1：esriFieldTypeDouble 

Area land use not logged (cleared) and converted to land use - current 

 

Current2：esriFieldTypeDouble 

Total Area Logged and Land Use 

 

Ext_Sl1：esriFieldTypeDouble 

Total logged and land use area - current - in extreme slope constraint area 

 

Ext_Alt1：esriFieldTypeDouble 

Total logged and land use area - current - in extreme altitude constraint area 

 

Ext_Kst1：esriFieldTypeDouble 

Total logged and land use area - current - in extreme ksrst constraint area 

 

Ext_In1：esriFieldTypeDouble 

Total logged and land use area - current - in extreme inundation constraint area 

 

Ext_Man1：esriFieldTypeDouble 

Total logged and land use area - current - in extreme mangrove constraint area 

 

Ser_Sl1：esriFieldTypeDouble 

Total logged and land use area - current - in serious slope/relief constraint area 

 

Ser_In1：esriFieldTypeDouble 

Total logged and land use area - current - in serious inundation constraint area 

 

Area2：esriFieldTypeDouble 

Revised gross forest area 
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Area3：esriFieldTypeDouble 

Revised adjusted forest area 

 

Forest_Vol：esriFieldTypeDouble 

Revised timber volume 

 

1.2.2  Ctrl_*_Concession_FMU  

Forest Mapping Unit(FMU) in Concession Area 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeInteger 

Province code 

 Value Domain 
CODE_N value of master_Province 

 

FMU：esriFieldTypeInteger 

FMU 

 Value Domain 
FMU value 

 

Zone：esriFieldTypeInteger 

Forest Zone code 

 Value Domain 
Zone code of master_Zone 

 

Map_No：esriFieldTypeDouble 

Original map number from 1:100,000 sheets 

 

Map_id：esriFieldTypeDouble 

1:100,000 sheet id 

 

Veg_Type：esriFieldTypeString 
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Vegetation type 

 

Veg_Area：esriFieldTypeDouble 

Vegetation area (hectares) 

 

 

Extreme_Slope：esriFieldTypeDouble 

Extreme physical limitations - slope (ha) - derived from PNGRIS overlay slope1> 

30 degrees (slope1=6) 

 

Extreme_Altitude：esriFieldTypeDouble 

Extreme physical limitations - altitude (ha) - derived from PNGRIS overlay 

altitude>2,400m (altitude=7 or 8) (Note: Extreme slope takes precedence) 

 

Extreme_Karst：esriFieldTypeDouble 

Extreme physical limitations - karst (ha) - derived from PNGRIS overlay landform 

polygonal karst (landform=55) 

 

Extreme_Inundation：esriFieldTypeDouble 

Extreme physical limitations - inundation (ha) - derived from PNGRIS overlay 

permanent or near permanent inundation > 80% of area (inund=5 or 6, iextent=4) 

 

Extreme_Mangrove：esriFieldTypeDouble 

Extreme physical limitations - mangrove (ha) - derived from FIM vegetation type 

of Mangrove (Veg_Type='M') 

 

Serious_SlopeRelief：esriFieldTypeDouble 

Serious physical limitations - slope and relief (ha) - derived from PNGRIS overlay 

slope1=20-30 degrees, slope2=0 or 30 degrees (slope2=0 or 6), very high or high 

relief (relief=4,5) 

 

Serious_Inundation：esriFieldTypeDouble 

Serious physical limitations - inundation (ha) - derived from PNGRIS overlay 

permanent or near permanent inundation 50- 80% of area (inund=5 or 6, 

iextent=3) 
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Extreme_Constraints_Area：esriFieldTypeDouble 

Total of extreme constraints area 

 

Serious_Constraints_Area：esriFieldTypeDouble 

Total of serious constraints area 

 

Prop_Extreme：esriFieldTypeDouble 

Proportion of FMU in extreme constraints area 

 

Prop_Serious：esriFieldTypeDouble 

Proportion of FMU in serious constraints area 

 

Protected_Area：esriFieldTypeDouble 

Protected area (DEC layer) in FMU 

 

Protected_Ext_Sl：esriFieldTypeDouble 

Protected area (DEC layer) in extreme slope area 

 

Protected_Ext_Alt：esriFieldTypeDouble 

Protected area (DEC layer) in extreme altitude area 

 

Protected_Ext_Kst：esriFieldTypeDouble 

Protected area (DEC layer) in extreme karst area 

 

Protected_Ext_In：esriFieldTypeDouble 

Protected area (DEC layer) in extreme inundation area 

 

Protected_Ext_Man：esriFieldTypeDouble 

Protected area (DEC layer) in extreme mangrove area 

 

Protected_Ser_Sl：esriFieldTypeDouble 

Protected area (DEC layer) in serious slope area 

 

Protected_Ser_In：esriFieldTypeDouble 

Protected area (DEC layer) in serious inundation area 
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Fragile_Forest_Type：esriFieldTypeInteger 

Fragile forest type flag (DEC) 

 

Forest_Type_No_Dist：esriFieldTypeString 

Forest type code without reference to disturbance 

 

Forest_Type_Base：esriFieldTypeString 

Forest type code without reference to disturbance or complex 

 

Gross_Forest_Area_75：esriFieldTypeDouble 

Gross forest area in 1975 

 

Disturbance_Index：esriFieldTypeDouble 

Level of disturbance (eg. 9 = 90% undisturbed) 

 

Complex_Percent：esriFieldTypeDouble 

Perecentage of vegetation type complex that is forest 

 

Adjusted_Forest_Area_75：esriFieldTypeDouble 

Gross forest area adjusted for disturbance and complex 

 

Timber_Volume：esriFieldTypeDouble 

Timber volume estimate for forest type 

 

Gross_Forest_Vol_75：esriFieldTypeDouble 

Gross forest volume in 1975 (adjusted forest area * timber volume) 

 

Logged_NotLandUse_75to96：esriFieldTypeDouble 

Area logged but not converted to land use - 1975 to 1996 

 

Logged_LandUse_75to96：esriFieldTypeDouble 

Area logged and converted to land use - 1975 to 1996 

 

LandUse_NotLogged_75to96：esriFieldTypeDouble 

Area land use not logged (cleared) and converted to land use - 1975 to 1996 
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LogAndLuse_75to96：esriFieldTypeDouble 

Total Area Logged and Land Use - 1975 to 1996 

 

LogAndLUse_75to96_Ext_Sl：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme slope constraint area 

 

LogAndLUse_75to96_Ext_Alt：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme altitude constraint area 

 

LogAndLUse_75to96_Ext_Kst：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme karst constraint area 

 

LogAndLUse_75to96_Ext_In：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme inundation constraint 

area 

 

LogAndLUse_75to96_Ext_Man：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme mangrove constraint 

area 

 

LogAndLUse_75to96_Ser_Sl：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in serious slope/relief constraint 

area 

 

LogAndLUse_75to96_Ser_In：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in serious inundation constraint area 

 

Logged_NotLandUse_Current：esriFieldTypeDouble 

Area logged but not converted to land use - current 

 

Logged_LandUse_Current：esriFieldTypeDouble 

Area logged and converted to land use - current 

 

LandUse_NotLogged_Current：esriFieldTypeDouble 

Area land use not logged (cleared) and converted to land use - current 
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LogAndLuse_Current：esriFieldTypeDouble 

Total Area Logged and Land Use 

 

LogAndLUse_Current_Ext_Sl：esriFieldTypeDouble 

Total logged and land use area - current - in extreme slope constraint area 

 

LogAndLUse_Current_Ext_Alt：esriFieldTypeDouble 

Total logged and land use area - current - in extreme altitude constraint area 

 

LogAndLUse_Current_Ext_Kst：esriFieldTypeDouble 

Total logged and land use area - current - in extreme ksrst constraint area 

 

LogAndLUse_Current_Ext_In：esriFieldTypeDouble 

Total logged and land use area - current - in extreme inundation constraint area 

 

LogAndLUse_Current_Ext_Man：esriFieldTypeDouble 

Total logged and land use area - current - in extreme mangrove constraint area 

 

LogAndLUse_Current_Ser_Sl：esriFieldTypeDouble 

Total logged and land use area - current - in serious slope/relief constraint area 

 

LogAndLUse_Current_Ser_In：esriFieldTypeDouble 

Total logged and land use area - current - in serious inundation constraint area 

 

Rev_Gross_Forest_Area：esriFieldTypeDouble 

Revised gross forest area 

 

Rev_Adjusted_Forest_Area：esriFieldTypeDouble 

Revised adjusted forest area 

 

Rev_Gross_Forest_Vol：esriFieldTypeDouble 

Revised timber volume 

 

plan_id：esriFieldTypeInteger 

Concession Area ID 
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1.2.3  ConcessionArea 

Concession Area or Proposed Concession Area 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

plan_id：esriFieldTypeDouble 

The Province (these numbers are formally listed in the Plans Listing document 

held by the Mapping Branch Manager. 

 

name：esriFieldTypeString 

Name of the new concession area. 

 

area：esriFieldTypeDouble 

Area in hectares of the new concession area. 

 

purchase：esriFieldTypeDate 

Purchase date 

 

exp：esriFieldTypeDate 

Expand date 

 

constype：esriFieldTypeString 

Concession Type 

 

status：esriFieldTypeString 

Status of a new concession area as Proposed. 

Value is 「Proposed」 or 「Concession」 

 

scale：esriFieldTypeString 

Scale value 

 

province：esriFieldTypeDouble 

Province code 
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 Value Domain 
CODE_N value of master_Province 

 

1.2.4  Protected_Area 

Protected Area 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

protected_id：esriFieldTypeDouble 

Protected area id 

 

name：esriFieldTypeString 

Name of the new protected area. 

 

type：esriFieldTypeString 

Protected area type 

 

gaz_date：esriFieldTypeString 

Designated date by protected area  

 

province：esriFieldTypeString 

Province code 

 Value Domain 
CODE_N value of master_Province 

 

location：esriFieldTypeString 

Protected area’s location (Character string) 

 

tenure：esriFieldTypeString 

Protected area’s holder   

 

area：esriFieldTypeDouble 

Area in hectares of the new protected area. 
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altitude：esriFieldTypeString 

Altitude description 

 

logitude：esriFieldTypeString 

Protected area’s location (longitude) 

 

latitude：esriFieldTypeString 

Protected area’s location (latitude) 

 

1.2.5  Extreme_Altitude 

Extreme physical limitations - altitude (ha) - derived from PNGRIS overlay 

altitude>2,400m (altitude=7 or 8) (Note: Extreme slope takes precedence) 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

provname：esriFieldTypeString 

Province name. 

 

area：esriFieldTypeDouble 

Ext Altitude Area (ha). 

 

altitude：esriFieldTypeString 

Description 

 

1.2.6  Extreme_Karst 

Extreme physical limitations - karst (ha) - derived from PNGRIS overlay landform 
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polygonal karst (landform=55) 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

provname：esriFieldTypeString 

Province name. 

 

area：esriFieldTypeDouble 

Ext Karst Area (ha). 

 

landfrom：esriFieldTypeSmallInteger 

Description 

 

1.2.7  Extreme_Slope 

Extreme physical limitations - slope (ha) - derived from PNGRIS overlay slope1> 30 

degrees (slope1=6) 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 
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provname：esriFieldTypeString 

Province name. 

 

area：esriFieldTypeDouble 

Ext Slope Area (ha). 

 

slope1：esriFieldTypeString 

Description 

 

1.2.8  Extreme_Inundation 

Extreme physical limitations - inundation (ha) - derived from PNGRIS overlay permanent 

or near permanent inundation > 80% of area (inund=5 or 6, iextent=4) 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

provname：esriFieldTypeString 

Province name. 

 

area：esriFieldTypeDouble 

Ext Altitude Area (ha). 

 

inund：esriFieldTypeString 

description1 

 

iextent：esriFieldTypeSmallInteger 

description2 
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1.2.9  Extreme_Mangrove 

Extreme physical limitations - mangrove (ha) - derived from FIM vegetation type of 

Mangrove (Veg_Type='M') 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

vegtype：esriFieldTypeString 

Vegetation Type. 

 

area：esriFieldTypeDouble 

Ext Altitude Area (ha). 

 

1.2.10  Serious_Inundation 

Serious physical limitations - inundation (ha) - derived from PNGRIS overlay permanent 

or near permanent inundation 50- 80% of area (inund=5 or 6, iextent=3) 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 
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provname：esriFieldTypeString 

province name. 

 

area：esriFieldTypeDouble 

Ser Inundation Area (ha). 

 

inund：esriFieldTypeString 

description1 

 

iextent：esriFieldTypeSmallInteger 

description2 

 

1.2.11  Serious_Relief 

Serious physical limitations - slope and relief (ha) - derived from PNGRIS overlay 

slope1=20-30 degrees, slope2=0 or 30 degrees (slope2=0 or 6), very high or high relief 

(relief=4,5) 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

provname：esriFieldTypeString 

Province name. 

 

area：esriFieldTypeDouble 

Ser Relief Area (ha). 

 

slope1：esriFieldTypeSmallInteger 

description1 
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slope2：esriFieldTypeString 

description2 

 

relief：esriFieldTypeString 

description3 

 

1.2.12  Logged_And_LUse_Current 

Total Area Logged and Land Use 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

area：esriFieldTypeDouble 

Total Area Logged and Land Use (ha). 

 

1.2.13  Logged_And_Luse_7596 

Total Area Logged and Land Use - 1975 to 1996 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 
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area：esriFieldTypeDouble 

Total Area Logged and Land Use (ha). 

 

1.2.14  Logged_NotLandUse_Current 

Area logged but not converted to land use 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

area：esriFieldTypeDouble 

Area logged but not converted to land use (ha). 

(Manual input) 

 

area2：esriFieldTypeDouble 

Area logged but not converted to land use (ha). 

(Automatic input by FIMS) 

 

type：esriFieldTypeString 

Logged over area type. 

 Value Domain 
Code value of master_LoggedOverType 

 

acharvol：esriFieldTypeDouble 

Actual harvest Volume. 

 

Plan_id：esriFieldTypeDouble 

plan_id to be associated with the area 

 

year：esriFieldTypeString 
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Years of logging 

 

name：esriFieldTypeString 

Name 

 

1.2.15  Logged_NotLandUse_7596 

Area logged but not converted to land use - 1975 to 1996 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

area：esriFieldTypeDouble 

Area logged but not converted to land use (ha). 

 

1.2.16  Logged_NotLandUse_Current_Merge 

Layer for process of area logged but not converted to land use - current 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

area：esriFieldTypeDouble 
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Area logged but not converted to land use (ha). 

 

1.2.17  Logged_LandUse_Current 

Area logged and converted to land use 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

area：esriFieldTypeDouble 

Area logged but not converted to land use (ha). 

(Manual input) 

 

area2：esriFieldTypeDouble 

Area logged but not converted to land use (ha). 

(Automatic input by FIMS) 

 

type：esriFieldTypeString 

Logged Over Area Type. 

 Value Domain 
Code of master_LoggedOverType 

 

ACHARVOL：esriFieldTypeDouble 

Actual harvest Volume. 

 

Plan_id：esriFieldTypeDouble 

Concession ID. 

 

YEAR：esriFieldTypeString 

Years of logging 
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name：esriFieldTypeString 

Name 

 

1.2.18  Logged_LandUse_7596 

Area logged and converted to land use - 1975 to 1996 

 

FeatureType：Polygon  

 

isAbstract : False 

 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

area：esriFieldTypeDouble 

Area logged but not converted to land use (ha). 

 

1.2.19  Logged_LandUse_Current_Merge 

Layer for processing of area logged and converted to land use - Current 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 
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area：esriFieldTypeDouble 

Area logged but not converted to land use (ha). 

 

1.2.20  LandUse_NotLogged_Current 

Area land use not logged (cleared) and converted to land use 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

area：esriFieldTypeDouble 

Area logged but not converted to land use (ha). 

(Manual input) 

 

area2：esriFieldTypeDouble 

Area logged but not converted to land use (ha). 

(Automatic input by FIMS) 

 

type：esriFieldTypeString 

Logged Over Area Type. 

 Value Domain 
Code of master_LoggedOverType 

 

ACHARVOL：esriFieldTypeDouble 

Actual harvest Volume. 

 

Plan_id：esriFieldTypeDouble 

Concession ID. 

 

YEAR：esriFieldTypeString 
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Years of logging. 

 

name：esriFieldTypeString 

Name 

 

1.2.21  LandUse_NotLogged_7596 

Area land use not logged (cleared) and converted to land use - 1975 to 1996 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

area：esriFieldTypeDouble 

Area logged but not converted to land use (ha). 

 

1.2.22  LandUse_NotLogged_Current_Merge 

Layer for processing of area land use not logged (cleared) and converted to land use – 

Current 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 
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area：esriFieldTypeDouble 

Area logged but not converted to land use (ha). 

 

1.2.23  PROV 

Layer for moving process to minimap in Province Window 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

code：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

province：esriFieldTypeString 

province name. 

 

1.2.24  F_STRIP_LINE 

Attribute of STRIP LINE of FIPS 

 

FeatureType：PolyLine  

 

isAbstract : False 

 

Attribute 

plan_id：esriFieldTypeInteger 

the Province (these numbers are formally listed in the Plans Listing document 

held by the Mapping Branch Manager. 

 

Survey_number ：esriFieldTypeString 

FIPS Survey Number. 

 

Survey_name ：esriFieldTypeString 
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FIPS Survey Name. 

 

Survey_date ：esriFieldTypeDate 

FIPS Survey Date. 

 

Block_number ：esriFieldTypeString 

FIPS Block Number. 

 

Strip ：esriFieldTypeString 

FIPS Strip Line Number. 

 

Strip_volume ：esriFieldTypeDouble 

Strip Forest Volume. 

 

Strip_volume_per_ha ：esriFieldTypeDouble 

Strip Forest Volume / ha. 

 

Start_lat ：esriFieldTypeDouble 

Strip Line Start Point (Lat). 

 

Start_lon ：esriFieldTypeDouble 

Strip Line Start Point (Lon). 

 

End_lat ：esriFieldTypeDouble 

Strip Line End Point (Lat). 

 

End_lon ：esriFieldTypeDouble 

Strip Line End Point (Lon). 

 

Last_update ：esriFieldTypeDate 

Calculation time and date of FIPS 

 

LOI_flag ：esriFieldTypeString 

Type of Survey 

 

Slope_min ：esriFieldTypeDouble 
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Minimum angle of slope 

 

Slope_max ：esriFieldTypeDouble 

Maximum angle of slope 

 

Elevation_min ：esriFieldTypeDouble 

Minimum elevation 

 

Elevation_max ：esriFieldTypeDouble 

Maximum elevation 

 

Vegetation ：esriFieldTypeString 

Representative vegetation type 

 

1.2.25  PlanArea 

Plan Area 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeDouble 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

area：esriFieldTypeDouble 

Plan area company reported (ha). 

 

area2：esriFieldTypeDouble 

Plan Area (automatic calculation by FIMS) (ha). 

 

type：esriFieldTypeString 

Plan Area Type. 

 Value Domain 
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Code value of master_PlanAreaType 

 

PRJHARVOL：esriFieldTypeDouble 

Project harvest Volume. 

 

Plan_id：esriFieldTypeDouble 

Concession ID. 

 

YEAR：esriFieldTypeString 

Years of logging. 

 

name：esriFieldTypeString 

Logged Over Area name. 

 

1.2.26  TMPINFO 

Calculation Temporary Table 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeInteger 

Province code 

 Value Domain 
CODE_N value of master_Province 

 

FMU：esriFieldTypeInteger 

FMU 

 Value Domain 
Sequence number from 1 in each province 

 

Zone：esriFieldTypeInteger 

Forest Zone code 

 Value Domain 
Zone number of master_Zone 



36 

 

Map_No：esriFieldTypeDouble 

Original map number from 1:100,000 sheets 

 

Map_id：esriFieldTypeDouble 

1:100,000 sheet id 

 

Veg_Type：esriFieldTypeString 

Vegetation type 

 

Veg_Area：esriFieldTypeDouble 

Vegetation area (hectares) 

 

Slope：esriFieldTypeDouble 

Extreme physical limitations - slope (ha) - derived from PNGRIS overlay slope1> 

30 degrees (slope1=6) 

 

Altitude：esriFieldTypeDouble 

Extreme physical limitations - altitude (ha) - derived from PNGRIS overlay 

altitude>2,400m (altitude=7 or 8) (Note: Extreme slope takes precedence) 

 

Karst：esriFieldTypeDouble 

Extreme physical limitations - karst (ha) - derived from PNGRIS overlay landform 

polygonal karst (landform=55) 

 

Inundation：esriFieldTypeDouble 

Extreme physical limitations - inundation (ha) - derived from PNGRIS overlay 

permanent or near permanent inundation > 80% of area (inund=5 or 6, iextent=4) 

 

Mangrove：esriFieldTypeDouble 

Extreme physical limitations - mangrove (ha) - derived from FIM vegetation type 

of Mangrove (Veg_Type='M') 

 

SlopeRelief：esriFieldTypeDouble 

Serious physical limitations - slope and relief (ha) - derived from PNGRIS overlay 

slope1=20-30 degrees, slope2=0 or 30 degrees (slope2=0 or 6), very high or high 
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relief (relief=4,5) 

 

Inundati0：esriFieldTypeDouble 

Serious physical limitations - inundation (ha) - derived from PNGRIS overlay 

permanent or near permanent inundation 50- 80% of area (inund=5 or 6, 

iextent=3) 

 

Area：esriFieldTypeDouble 

Total of extreme constraints area 

 

Area0：esriFieldTypeDouble 

Total of serious constraints area 

 

Extreme：esriFieldTypeDouble 

Proportion of FMU in extreme constraints area 

 

Serious：esriFieldTypeDouble 

Proportion of FMU in serious constraints area 

 

Area1：esriFieldTypeDouble 

Protected area (DEC layer) in FMU 

 

Ext_Sl：esriFieldTypeDouble 

Protected area (DEC layer) in extreme slope area 

 

Ext_Alt：esriFieldTypeDouble 

Protected area (DEC layer) in extreme altitude area 

 

Ext_Kst：esriFieldTypeDouble 

Protected area (DEC layer) in extreme karst area 

 

Ext_In：esriFieldTypeDouble 

Protected area (DEC layer) in extreme inundation area 

 

Ext_Man：esriFieldTypeDouble 

Protected area (DEC layer) in extreme mangrove area 
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Ser_Sl：esriFieldTypeDouble 

Protected area (DEC layer) in serious slope area 

 

Ser_In：esriFieldTypeDouble 

Protected area (DEC layer) in serious inundation area 

 

Type：esriFieldTypeInteger 

Fragile forest type flag (DEC) 

 

No_Dist：esriFieldTypeString 

Forest type code without reference to disturbance 

 

VEG_TYPE_1：esriFieldTypeString 

Forest type code 1 

 

VEG_TYPE_2：esriFieldTypeString 

Forest type code 2 

 

VEG_TYPE_3：esriFieldTypeString 

Forest type code 3 

 

Type_Base：esriFieldTypeString 

Forest type code without reference to disturbance or complex 

 

Area_75：esriFieldTypeDouble 

Gross forest area in 1975 

 

Index_：esriFieldTypeDouble 

Level of disturbance (eg. 9 = 90% undisturbed) 

 

Percent_：esriFieldTypeDouble 

Perecentage of vegetation type complex that is forest 

 

Area_750：esriFieldTypeDouble 

Gross forest area adjusted for disturbance and complex 
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Volume：esriFieldTypeDouble 

Timber volume estimate for forest type 

 

Vol_75：esriFieldTypeDouble 

Gross forest volume in 1975 (adjusted forest area * timber volume) 

 

to96：esriFieldTypeDouble 

Area logged but not converted to land use - 1975 to 1996 

 

to960：esriFieldTypeDouble 

Area logged and converted to land use - 1975 to 1996 

 

to961：esriFieldTypeDouble 

Area land use not logged (cleared) and converted to land use - 1975 to 1996 

 

Ext_Sl0：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme slope constraint area 

 

Ext_Alt0：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme altitude constraint area 

 

Ext_Kst0：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme karst constraint area 

 

Ext_In0：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme inundation constraint 

area 

 

Ext_Man0：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in extreme mangrove constraint 

area 

 

Ser_Sl0：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in serious slope/relief constraint 

area 
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Ser_In0：esriFieldTypeDouble 

Total logged and land use area 1975 to 1996 in serious inundation constraint area 

 

Current_：esriFieldTypeDouble 

Area logged but not converted to land use - current 

 

Current0：esriFieldTypeDouble 

Area logged and converted to land use - current 

 

Current1：esriFieldTypeDouble 

Area land use not logged (cleared) and converted to land use - current 

 

Current2：esriFieldTypeDouble 

Total Area Logged and Land Use 

 

Ext_Sl1：esriFieldTypeDouble 

Total logged and land use area - current - in extreme slope constraint area 

 

Ext_Alt1：esriFieldTypeDouble 

Total logged and land use area - current - in extreme altitude constraint area 

 

Ext_Kst1：esriFieldTypeDouble 

Total logged and land use area - current - in extreme ksrst constraint area 

 

Ext_In1：esriFieldTypeDouble 

Total logged and land use area - current - in extreme inundation constraint area 

 

Ext_Man1：esriFieldTypeDouble 

Total logged and land use area - current - in extreme mangrove constraint area 

 

Ser_Sl1：esriFieldTypeDouble 

Total logged and land use area - current - in serious slope/relief constraint area 

 

Ser_In1：esriFieldTypeDouble 

Total logged and land use area - current - in serious inundation constraint area 



41 

 

Area2：esriFieldTypeDouble 

Revised gross forest area 

 

Area3：esriFieldTypeDouble 

Revised adjusted forest area 

 

Forest_Vol：esriFieldTypeDouble 

Revised timber volume 

 

plan_id：esriFieldTypeInteger 

the Province (these numbers are formally listed in the Plans Listing document 

held by the Mapping Branch Manager. 

 

name：esriFieldTypeString 

name of the new concession area. 

 

constype：esriFieldTypeString 

Concession Type 

 

status：esriFieldTypeString 

status of a new concession area as Proposed. 

Value is 「Proposed」 or 「Concession」 

 

scale：esriFieldTypeString 

scale value 

 

1.2.27  TMPLAYER 

Calculation Temporary Table 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeInteger 
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Province code 

 Value Domain 
CODE_N value of master_Province 

 

FMU：esriFieldTypeInteger 

FMU 

 Value Domain 
Seuence number from one in each province 

 

Zone：esriFieldTypeInteger 

Forest Zone code 

 Value Domain 
Zone number of master_Zone 

 

PLAN_ID：esriFieldTypeDouble 

Concession Area ID 

 

1.2.28  TMPLAYER2 

Calculation Temporary Table 

 

FeatureType：Polygon  

 

isAbstract : False 

 

Attribute 

province：esriFieldTypeInteger 

Province code 

 Value Domain 
CODE_N value of master_Province 

 

FMU：esriFieldTypeInteger 

FMU 

 Value Domain 
Sequence number from 1 in each province 

 

Zone：esriFieldTypeInteger 
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Forest Zone code 

 Value Domain 
Zone number of master_Zone 

 

PLAN_ID：esriFieldTypeDouble 

Concession Area ID 

 

KEY_ID：esriFieldTypeString 

Key_ID 
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1.2.29  Master_Species 

species Percentages by Forest Type by zone 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

province：int 

Province code. 

 Value Domain 
CODE_N value of master_Province 

 

zone：int 

Forest Zone code 

 Value Domain 
Zone number of master_Zone 

 

species：int 

species name.(Forest Type name) 

 

D：double 

Spacies percentages by Forest Type by zone by Type “D” 

 

D/Fsw：double 

Spacies percentages by Forest Type by zone by Type “D/Fsw” 

 

D/W：double 

Spacies percentages by Forest Type by zone by Type “D/W” 

 

FriK：double 

Spacies percentages by Forest Type by zone by Type “FriK” 

 

FriK/Ps：double 

Spacies percentages by Forest Type by zone by Type “FriK/Ps” 
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FriTb：double 

Spacies percentages by Forest Type by zone by Type “FriTb” 

 

FriTb/Wri：double 

Spacies percentages by Forest Type by zone by Type “FriTb/Wri” 

 

Fsw：double 

Spacies percentages by Forest Type by zone by Type “Fsw” 

 

FswC：double 

Spacies percentages by Forest Type by zone by Type “FswC” 

 

Fsw/Tb：double 

Spacies percentages by Forest Type by zone by Type “Fsw/Tb” 

 

Hl：double 

Spacies percentages by Forest Type by zone by Type “Hl” 

 

Hl/Hm：double 

Spacies percentages by Forest Type by zone by Type “Hl/Hm” 

 

HlN：double 

Spacies percentages by Forest Type by zone by Type “HlN” 

 

Hm：double 

Spacies percentages by Forest Type by zone by Type “Hm” 

 

Hm/D：double 

Spacies percentages by Forest Type by zone by Type “Hm/D” 

 

Hm/D/Fsw：double 

Spacies percentages by Forest Type by zone by Type “Hm/D/Fsw” 

 

Hm/Fsw：double 

Spacies percentages by Forest Type by zone by Type “Hm/Fsw” 
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Hm/Fsw/Wsw：double 

Spacies percentages by Forest Type by zone by Type “Hm/Fsw/Wsw” 

 

Hm/Hs：double 

Spacies percentages by Forest Type by zone by Type “Hm/Hs” 

 

Hm/Hs/Fsw：double 

Spacies percentages by Forest Type by zone by Type “Hm/Hs/Fsw” 

 

Hm/HsN：double 

Spacies percentages by Forest Type by zone by Type “Hm/HsN” 

 

Hm/Sc：double 

Spacies percentages by Forest Type by zone by Type “Hm/Sc” 

 

HmAr：double 

Spacies percentages by Forest Type by zone by Type “HmAr” 

 

Hmd：double 

Spacies percentages by Forest Type by zone by Type “Hmd” 

 

Hme/Hm：double 

Spacies percentages by Forest Type by zone by Type “Hme/Hm” 

 

Hm/HmAr：double 

Spacies percentages by Forest Type by zone by Type “Hm/HmAr” 

 

Hm/Ps：double 

Spacies percentages by Forest Type by zone by Type “Hm/Ps” 

 

Hs：double 

Spacies percentages by Forest Type by zone by Type “Hs” 

 

HsAr：double 

Spacies percentages by Forest Type by zone by Type “HsAr” 
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Hs/Fsw：double 

Spacies percentages by Forest Type by zone by Type “Hs/Fsw” 

 

Hs/Hm：double 

Spacies percentages by Forest Type by zone by Type “Hs/Hm” 

 

Hs/Ps：double 

Spacies percentages by Forest Type by zone by Type “Hs/Ps” 

 

Hs/Sa：double 

Spacies percentages by Forest Type by zone by Type “Hs/Sa” 

 

Hse：double 

Spacies percentages by Forest Type by zone by Type “Hse” 

 

L：double 

Spacies percentages by Forest Type by zone by Type “L” 

 

L/Lc：double 

Spacies percentages by Forest Type by zone by Type “L/Lc” 

 

L/LN：double 

Spacies percentages by Forest Type by zone by Type “L/LN” 

 

L/Ls：double 

Spacies percentages by Forest Type by zone by Type “L/Ls” 

 

LAr：double 

Spacies percentages by Forest Type by zone by Type “LAr” 

 

Lc：double 

Spacies percentages by Forest Type by zone by Type “Lc” 

 

LN：double 

Spacies percentages by Forest Type by zone by Type “LN” 
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LN/LsN：double 

Spacies percentages by Forest Type by zone by Type “LN/LsN” 

 

Ls：double 

Spacies percentages by Forest Type by zone by Type “Ls” 

 

LsAr：double 

Spacies percentages by Forest Type by zone by Type “LsAr” 

 

Ls/L：double 

Spacies percentages by Forest Type by zone by Type “Ls/L” 

 

Ls/Lc：double 

Spacies percentages by Forest Type by zone by Type “Ls/Lc” 

 

LsN：double 

Spacies percentages by Forest Type by zone by Type “LsN” 

 

LsN/LN：double 

Spacies percentages by Forest Type by zone by Type “LsN/LN” 

 

M：double 

Spacies percentages by Forest Type by zone by Type “M” 

 

Pl：double 

Spacies percentages by Forest Type by zone by Type “Pl” 

 

Pl/FriK：double 

Spacies percentages by Forest Type by zone by Type “Pl/FriK” 

 

Pl/Fsw：double 

Spacies percentages by Forest Type by zone by Type “Pl/Fsw” 

 

Pl/Hm：double 

Spacies percentages by Forest Type by zone by Type “Hm” 
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Po：double 

Spacies percentages by Forest Type by zone by Type “Po” 

 

Po/FriK：double 

Spacies percentages by Forest Type by zone by Type “Po/FriK” 

 

Po/Fsw：double 

Spacies percentages by Forest Type by zone by Type “Po/Fsw” 

 

Po/FswTb：double 

Spacies percentages by Forest Type by zone by Type “Po/FswTb” 

 

Po/Hs：double 

Spacies percentages by Forest Type by zone by Type “Po/Hs” 

 

Po/Pl：double 

Spacies percentages by Forest Type by zone by Type “Po/Pl” 

 

Po/Wsw：double 

Spacies percentages by Forest Type by zone by Type “Po/Wsw” 

 

Ps：double 

Spacies percentages by Forest Type by zone by Type “Ps” 

 

Ps/FriK：double 

Spacies percentages by Forest Type by zone by Type “Ps/FriK” 

 

W：double 

Spacies percentages by Forest Type by zone by Type “W” 

 

1.2.30  Master_Report 

Report List 

 

FeatureType：ObjectClass  
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isAbstract : False 

 

Attribute 

Description：string 

Viewer’s Report Name 

 

ReportName：string 

System’s Report Name. 

 

ReportType：int 

Report Type. 

 

Group：int 

Group ID. 1=Province Report, 2=Concession Report, 3=Proposed Concession 

Report 

 

Priority：int 

Viewer’s Sort Key 

 

1.2.31  Ctrl_TimberVolume 

TimberVolume data by Zone 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

Province：int 

Province code 

 Value Domain 
CODE_N value of master_Province 
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zone：int 

Forest Zone code 

 Value Domain 
Zone number of master_Zone 

 

VegType：string 

Vegetation Type. 

 

Vol/ha：double 

TimberVolume per ha 

 

OriginalVol/ha：double 

Original TimberVolume per ha. 

This field is not update. 

 

 

Comments：double 

Comment field. 

 

1.2.32  Master_Zone 

zone data 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

zone：int 

Forest Zone code 

 

name：string 

Forest Zone name 

 

description：string 

description 
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1.2.33  Master_VegTypes 

Vegetation Type data 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

VegType：string 

Vegetation Type 

 

Group：string 

Vegetation Group ID 

 

description：string 

description 

 

Merchantable：int 

Merchantable 0 = false, 1 = true. 

 

1.2.34  Master_Province 

Province data 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

CODE_N：int 

Province code 

 

CODE_A：string 

Province Short Name 

 

DESCRIP：string 
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Province Name 

 

1.2.35  Master_SusceptibleVegTypes 

Susceptible Vegetation Type data 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

Province：int 

Province code 

 Value Domain 
CODE_N value of master_Province 

 

FMU：int 

FMU code. 

 Value Domain 
FMU value 

 

VegType：string 

Vegetation Type. 

 

SusceptibleType：string 

SusceptibleType 

 

1.2.36  Master_user 

user data 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

username：string 
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user name ( Unique Key ) 

 

password：string 

login password. 

 

authority：int 

user’s authority 

0 = viewer 

1 = high rank user 

2 = administrator 

 

1.2.37  Master_Database 

Layer Management 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

Database：string 

Layer name which Layer Management displays 

 

Last_Update：date/time 

Date last modified 

 

Del：int 

Delete flag 

 

1.2.38  Master_TmpReport 

Report Management 

 

FeatureType：ObjectClass  

 

isAbstract : False 
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Attribute 

TmpReportName：string 

Report name 

 

sysdate：date/time 

report output date 

 

MachineName：string 

Report output computer name 

 

DeleteFlag：int 

Delete flag 

 

1.2.39  Master_LoggedOverType 

Management of type of Logged Over Area 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

id：int 

id 

 

name：string 

type name 

 

 

1.2.40  Master_PlanAreaType 

Management of type of Plan Area 

 

FeatureType：ObjectClass  

 

isAbstract : False 
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Attribute 

id：int 

id 

 

name：string 

Type name 

 

1.2.41  F_SURVEY_SUMMARY 

Management of TimberVolume related to Survey of FIPS 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

Plan_id：int 

Concession ID. 

 

SURVEY_NUMBER：string 

Survey Number of FIPS 

 

SURVEY_Name：string 

Survey Name of FIPS 

 

Adjusted_forest_area：double 

Adjusted forest Area of FIPS 

 

VOL10_per_ha：double 

10cm-19cm TimberVolume of FIPS 

 

PVOL_per_ha：double 

20cm-49cm TimberVolume of FIPS 

 

SVOL_per_ha：double 

50cm over TimberVolume of FIPS 
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TotalVol_per_ha：double 

20cm over TimberVolume of FIPS 

 

MVOL_per_ha：double 

50cm over (rank A-C) TimberVolume of FIPS. 

 

VOL10_grp_per_ha：double 

10cm-19cm TimberVolume belonging to MEP group 1 and 2 of FIPS 

 

PVOL_ grp_per_ha：double 

20cm-49cm TimberVolume belonging to MEP group 1 and 2 of FIPS  

 

SVOL_ grp_per_ha：double 

50cm over TimberVolume belonging to MEP group 1 and 2 of FIPS  

 

TotalVol_ grp_per_ha：double 

20cm over TimberVolume belonging to MEP group 1 and 2 of FIPS  

 

MVOL_ grp_per_ha：double 

50cm over (rank A-C) TimberVolume belonging to MEP group 1 and 2 of FIPS  

 

1.2.42  Ctrl_LastCalclationDate 

Management of last processed date 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

province：int 

Province code 

 Value Domain 
CODE_N value of master_Province 

 

 

ConcessionFrag：int 
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0 = Calclation for Province 

1 = Calclation for Concession 

 

CalcDate：date/time 

Date and time of calclation 

 

1.2.43  concessionFile 

Management of files uploaded on Concession screen 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

id：int 

Primary Key. 

 

Plan_id：int 

plan_id of Concession related to files 

 

filename：string 

File name uploaded 

 

fdata：varbinary 

Soft copy uploaded 

Soft copies can not be downloaded by using except FIMS because the file is 

binary data. 
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2  Data content and structure of FIPS Database 
2.1  FIPS application schema 

 

 



60 

2.2  Documentation of FIPS application Schema 

 

2.2.1  Survey Information  

Dataset of Survey of FIPS 

 

FeatureType：ObjectClass  

 

isAbstract : True 

 

Attribute 

 

2.2.2  Survey Record  

Details of Survey 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

Survey Number：string 

Survey Number (unique). 

The first two digits shows province Number, the last three digits shows sequence 

number from 001 to 999 

 Value Domain 

01001～19999 

 

Name of Survey：string 

Survey name. 

 

Date of the Survey (Completion date) ：string 

Survey date. 

 

File Reference Number：string 

Reference number of file 

Gross Area of Resource Area in Hectares：int 
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Total area of all blocks 

 

Number or Blocks：int 

Number of blocks 

 Value Domain 

1～10 

 

Adjusted Net Forest Area：double 

Area of Adjusted Net Forest Area 

 

LOI Flag：LOI Code 

Type of Survey 

 Value Domain 

code value 

0 Virgin 

1 LOI 

2 Unlogged Forest Survey 

 

Minimum Slope：double 

Minimum angle of slope 

 

Maximum Slope：double 

Maximum angle of slope 

 

Minimum Elevation：double 

Minimum elevation 

 

Maximum Elevation：double 

Maximum elevation 

 

Plan id：int 

Plan Id of Concession in FIMS 

The first two digits shows province number, the last three digits shows sequential 

code from 001 to 999 

 Value Domain 

1000～99999 
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Vegetation：string 

Vegetation Type of FIMS 

 Value Domain 
VegType value of Master VegType(FIMS) 

 

2.2.3  Block Record  

Block details related to survey 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

Block Number：string 

Block Number. 

 Value Domain 

01～10. 

 

Area in Hectares：int 

Area of Block 

 

Whether of not data entry has been completed：boolean 

Existence or non-existence of Field Book Data 

 

2.2.4  Survey Details  

The information to link Survey Record and Field Record 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

Survey Number：string 

Survey Number. 

 Value Domain 
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Survey Number value of Survey Record 

 

Block Number：string 

Block Number. 

 Value Domain 

01～10. 

 

2.2.5  Field Record 

Data related to Strip Line and Plot Area 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

Strip Number：string 

Strip Number. 

 Value Domain 

001～999. 

 

Forest Type：string 

Forest Type. 

 Value Domain 
TypeCode value of Master ForestType 

 

Plot Number：string 

Plot Number. 

 

Plot Type：Plot Type 

Plot Type. 

 Value Domain 

code Main Plot Area Sub plot Area 

1 2000m2 2000m2 

2 2000m2 1000m2 

3 1000m2 1000m2 
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code Main Plot Area Sub plot Area 

4 1000m2 500m2 

5 1257m2 1257m2 

6 1257m2 628m2 

7 1257m2 314m2 

 

2.2.6  Strip Location 

Coordinates of the start point and the end point for Strip Line 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

Start Point：Address 

Coordinates (latitude and longitude) of the start point of Strip Line 

 

End Point：Address 

Coordinates (latitude and longitude) of the end point of Strip Line 

 

2.2.7  Trees 

Each tree of Field Book 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

tree #：int 

Page Number. 

Field Book can have twelve records in a page 

 

Species：string 

Species Code. 

 Value Domain 
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Code value of Master Species 

 

Diameter：int 

Diameter. 

 

Length：int 

Length. 

 

Form：string 

Form Class. 

 Value Domain 

code value 

1 A 

2 B 

3 C 

4 D 

5 E 

6 F 

 

2.2.8  Master Species 

Master table (Species). 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

Code：string 

Species Code (unique). 

 

MEP Group：string 

MEP Group. 

 

Occurrence：int 

Occurrence. 
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Species Name：string 

Species Name. 

 

Synomym or old name：string 

Synomym or old name. 

 

Family Name：string 

Family Name. 

 

Standard Trade：string 

Standard Trade. 

 

Common Name：string 

Common Name. 

 

2.2.9  Master Province 

Master table (Province). 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

Province Number：string 

Province Number (unique). 

 Value Domain 

01～19. 

 

Province Name：string 

Province Name. 

 

2.2.10  Master ForestType 

Master table (Forest Type). 
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FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

Type Code：string 

Forest Type Code(unique). 

 

Topography：string 

Topography. 

 

Forest Descr：string 

Forest Descr. 

 

Description：string 

Description. 

 

Dominant species or feature：string 

Dominant species or feature. 

 

Altitudinal Minimum：int 

Altitudinal Minimum. 

 

Range Maximum：int 

Range Maximum. 

 

2.2.11  Master VegType(FIMS) 

Master table (VegType by FIMS). 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

VegType：string 
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Veg Type Code(unique). 

 

Group：string 

Veg Type group name. 

 

Description：string 

Description. 

 

Merchantable：int 

Merchantable. 

 Value Domain 
0 = false 

1 = true 

 

2.2.12  Master User 

Master table (User). 

 

FeatureType：ObjectClass  

 

isAbstract : False 

 

Attribute 

User Name：string 

User name(unique). 

 

password：string 

Password. 

 

AUTHORITY：Auth Type 

AUTHORITY. 

 Value Domain 

code value 

0 Administrator 

1 user 

2 developer 

 



 

 

 

 

 

添付資料 3 全国森林基盤図 Version 1 （州毎の出力図面） 



Forest Basemap 2012 (Version 1): Forest & Vegetation Type

Color Code Forest/Vegetation Type Defin ition (based on PNGRIS/FIMS) Elevation

P Low Altitude Forest on Plains & Fans Low Altitude Forest on Plains and Fans, below 1,000m

H Low Altitude Forest on Uplands Low Altitude Forest on Uplands below 1,000m

L Lower Montane Forest Lower Montane Forest above 1,000m

Mo Montane Forest Montane Forest above 3,000m

D Dry Seasonal Forest
The forest is restricted to southwest PNG in a low-rainfall area (1800-2500mm), and occurs on well to 
imperfectly-drained, very gently undulating to low hilly terrain.

B Littoral Forest The forest occurs on dry sandy beach plains and on beach ridges

Fri Seral Forest
The forest is heterogeneous, comprising many seral stages, from low forest to original levee forest, following 
changes in the course of a river.

Fsw Swamp Forest The forest occurs on low-lying, permanently swampy river back plains and deltas.

M Mangrove Forest
All vegetation of the saline or brackish communities, tidal zone. Ranges from forest over 30m tall, to low 
halophytic herbs.

W Woodland
Tree with separated crowns. Generally low, up to 10m tall, rarely to 20m, but lower in the case of non-tree life 
forms e.g. sago palms and Pandanus.  A clearly visible ground layer of shrubs, herbs and/or grasses.

Sa Savanna
Scattered to moderately dense layer of trees.  Generally less than 6m tall. A clearly visible ground layer of herbs 
and/or grasses

Sc Scrub Dense shrubs with or without scattered low trees. Generally less than 6m tall

G Grassland and Herbland Grasses, sedges, herbs and very low woody shrubs.  Generally less than 3m tall. Scattered trees may be present
Ga Grassland (Alpine) Grasses: above 3,200m
Gi Grassland (Subalpine) Grasses: 2,500m - 3,200m
Z Bare areas
U Larger Urban Centres
E Lake & Larger Rivers
O Cropland/Agriculture land
Qf Forest Plantation
Qa Plantation other than Forest















































Vegetation Type Area calculated from Forest Basemap 2012 (Version 1)

Forest BaseMap(ver.1: Landcover + Draft Cropland/Agriculture landuse): Vegetation Type Area (ha) x Province

VEG VEGNAME SUM CEN NCD ORO MIL GUL WES MOR MAD ESK WSK SIM ENG EHY SHY HLA WHY JWK WNB ENB MAN NIR ARB

P Low Altitude Forest on Plains & Fans 8,807,748 293,750 94 366,161 221,194 1,075,639 3,220,005 91,822 487,003 707,761 1,033,140 8,351 2,737 2,098 153,930 22,430 9,478 9,270 523,167 135,528 67,885 141,382 234,924
H Low Altitude Forest on Uplands 12,404,244 1,100,041 46 727,773 652,785 1,215,112 629,402 843,806 920,004 1,025,687 1,433,010 116,969 69,566 56,309 436,558 145,102 21,918 70,655 1,095,925 829,389 106,676 529,731 377,781
L Lower Montane Forest 8,221,846 679,811 485,631 135,618 154,309 290,116 1,420,922 481,891 230,304 610,991 283,143 624,163 596,689 626,502 740,816 141,218 201,264 68,328 269,522 102,982 77,625
Mo Montane Forest 358,050 39,092 30,140 645 2,679 39,274 21,832 649 18,044 15,856 110,171 13,339 12,042 19,521 16,103 18,664
D Dry Seasonal Forest 957,387 957,387
B Littoral Forest 69,994 11,989 681 4,318 1,011 37,485 1,091 1,056 2,040 2,237 1,110 2,447 4,530
Fri Seral Forest 158,783 6,736 26,425 1,144 353 9,825 3,658 5,780 24,339 2,975 21,096 18,296 6,857 31,300
Fsw Swamp Forest 2,070,809 9,067 18,206 1,122 498,173 684,835 20,438 95,092 510,195 137,546 373 15,444 241 88 47 25,802 60 642 53,439
M Mangrove Forest 524,582 48,508 296 14,027 49,993 240,787 117,673 2,914 173 17,789 657 8,307 2,565 3,617 14,612 2,662
W Woodland 3,091,027 173,332 1,096 177,449 11,913 138,596 1,596,062 51,913 97,841 685,667 66,725 14,341 380 33,786 2,306 20,241 19,379
Sa Savanna 651,825 113,965 9,919 23,591 76 14,455 489,695 124
Sc Scrub 394,340 6,738 982 1,628 1,329 376,410 13 276 114 112 30 6,708
G Grassland and Herbland 3,357,766 249,049 430 143,755 132,610 79,463 1,026,961 301,373 168,836 637,169 111,323 30,652 26,276 194,267 62,960 31,533 13,136 9,125 37,525 21,367 6,243 28,038 45,676
Ga Grassland (Alpine) 113,383 19,591 8,392 2,161 1 923 10,968 2,313 508 1,794 792 41,535 853 3,363 17,863 2,200 111 15
Gi Grassland (Subalpine) 88,624 11,523 6,503 427 338 18,136 6,816 189 2,540 6,168 8,046 663 13,717 753 8,714 4,091
Z Bare areas 21,950 95 397 22 8,701 2,786 0 1,501 19 169 1,459 200 320 233 1,069 1,229 999 2,752
U Larger Urban Centres 21,484 387 5,918 239 517 188 648 7,211 1,415 704 256 592 819 319 0 172 595 497 332 672
E Lake & Larger Rivers 579,052 17,749 149 19,328 4,768 40,357 248,378 22,471 28,490 116,120 26,647 3,234 2,149 3,888 11,718 3,988 755 1,177 13,805 5,346 399 2,760 5,377
O Cropland/Agriculture land 4,504,510 149,657 1,011 134,574 256,982 107,839 186,173 469,892 540,728 484,334 141,658 147,416 338,452 236,155 265,017 187,467 228,565 159,974 130,701 201,458 6,106 78,779 51,571
Qf Forest Plantation 66,380 18,083 0 0 1,208 0 0 17,686 4,850 0 0 0 25 4,887 315 0 1,464 0 0 17,863 0 0 0
Qa Plantation other than Qf 427,005 6,413 0 78,392 25,647 1,061 0 34,970 23,397 1,335 1,280 168 122 4,539 23 0 9,578 5,910 161,009 21,471 719 16,165 34,805

SUM 46,890,788 2,955,577 19,941 2,263,290 1,504,458 3,567,345 9,875,015 3,367,258 2,890,302 4,444,790 3,592,598 613,341 1,223,758 1,114,676 1,617,708 1,170,407 453,535 480,521 2,121,916 1,529,472 193,140 942,521 949,218

Forest Cover Area (ha)
Forest 33,639,823 2,207,077 436 1,669,044 1,068,027 3,185,385 5,949,406 2,441,611 2,017,681 2,518,764 3,238,600 424,319 807,035 673,322 1,244,791 928,110 190,268 299,900 1,743,735 1,275,670 178,177 796,206 782,261

Forest&Woodland 36,730,851 2,380,409 1,532 1,846,492 1,079,940 3,323,980 7,545,468 2,493,524 2,115,522 3,204,431 3,305,324 424,319 807,035 673,322 1,259,132 928,490 190,268 299,900 1,777,521 1,277,976 178,177 816,448 801,641
* Forest&Woodland&Scrub&Savanna 37,777,015 2,501,112 12,434 1,871,710 1,081,346 3,338,435 8,411,573 2,493,536 2,115,522 3,204,431 3,305,600 424,319 807,159 673,322 1,259,132 928,604 190,268 299,900 1,777,633 1,278,006 178,177 816,448 808,348

Forest Cover Rate (%)
Forest 71.7% 74.7% 2.2% 73.7% 71.0% 89.3% 60.2% 72.5% 69.8% 56.7% 90.1% 69.2% 65.9% 60.4% 76.9% 79.3% 42.0% 62.4% 82.2% 83.4% 92.3% 84.5% 82.4%

Forest&Woodland 78.3% 80.5% 7.7% 81.6% 71.8% 93.2% 76.4% 74.1% 73.2% 72.1% 92.0% 69.2% 65.9% 60.4% 77.8% 79.3% 42.0% 62.4% 83.8% 83.6% 92.3% 86.6% 84.5%
* Forest&Woodland&Scrub&Savanna 80.6% 84.6% 62.4% 82.7% 71.9% 93.6% 85.2% 74.1% 73.2% 72.1% 92.0% 69.2% 66.0% 60.4% 77.8% 79.3% 42.0% 62.4% 83.8% 83.6% 92.3% 86.6% 85.2%
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Above Ground Living Biomass
Forest BaseMap(ver.1: Landcover + Draft Cropland/Agriculture landuse): Biomass (above ground living) x Province

VEG VEGNAME SUM CEN NCD ORO MIL GUL WES MOR MAD ESK WSK SIM ENG EHY SHY HLA WHY JWK WNB ENB MAN NIR ARB

P Low Altitude Forest on Plains & Fans 2,642.32 88.13 0.03 109.85 66.36 322.69 966.00 27.55 146.10 212.33 309.94 2.51 0.82 0.63 46.18 6.73 2.84 2.78 156.95 40.66 20.37 42.41 70.48
H Low Altitude Forest on Uplands 3,721.27 330.01 0.01 218.33 195.84 364.53 188.82 253.14 276.00 307.71 429.90 35.09 20.87 16.89 130.97 43.53 6.58 21.20 328.78 248.82 32.00 158.92 113.33
L Lower Montane Forest 1,151.06 95.17 0.00 67.99 18.99 21.60 40.62 198.93 67.46 32.24 85.54 39.64 87.38 83.54 87.71 103.71 19.77 28.18 9.57 37.73 0.00 14.42 10.87
Mo Montane Forest 50.13 5.47 0.00 4.22 0.09 0.00 0.38 5.50 3.06 0.09 2.53 2.22 15.42 1.87 1.69 2.73 2.25 2.61 0.00 0.00 0.00 0.00 0.00
D Dry Seasonal Forest 172.33 0.00 0.00 0.00 0.00 0.00 172.33 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
B Littoral Forest 12.60 2.16 0.00 0.12 0.78 0.18 6.75 0.20 0.19 0.37 0.40 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.20 0.44 0.00 0.00 0.82
Fri Seral Forest 47.63 2.02 0.00 7.93 0.34 0.11 2.95 1.10 1.73 7.30 0.89 0.00 0.00 0.00 0.00 0.00 0.00 0.00 6.33 5.49 0.00 2.06 9.39
Fsw Swamp Forest 621.24 2.72 0.00 5.46 0.34 149.45 205.45 6.13 28.53 153.06 41.26 0.00 0.11 0.00 4.63 0.07 0.03 0.01 7.74 0.02 0.00 0.19 16.03
M Mangrove Forest 100.72 9.31 0.06 2.69 9.60 46.23 22.59 0.56 0.03 3.42 0.13 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1.59 0.49 0.69 2.81 0.51
W Woodland 401.83 22.53 0.14 23.07 1.55 18.02 207.49 6.75 12.72 89.14 8.67 0.00 0.00 0.00 1.86 0.05 0.00 0.00 4.39 0.30 0.00 2.63 2.52
Sa Savanna 45.63 7.98 0.69 1.65 0.01 1.01 34.28 0.00 0.00 0.00 0.00 0.00 0.01 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Sc Scrub 27.60 0.47 0.07 0.11 0.09 0.00 26.35 0.00 0.00 0.00 0.02 0.00 0.00 0.00 0.00 0.01 0.00 0.00 0.01 0.00 0.00 0.00 0.47
G Grassland and Herbland 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Ga Grassland (Alpine) 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Gi Grassland (Subalpine) 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Z Bare areas 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
U Larger Urban Centres 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
E Lake & Larger Rivers 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
O Cropland/Agriculture land 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Qf Forest Plantation 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Qa Plantation other than Qf 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

SUM 8,994.37 565.98 1.00 441.43 293.97 923.83 1874.00 499.85 535.83 805.65 879.29 79.46 124.62 102.93 273.04 156.84 31.47 54.78 515.56 333.95 53.06 223.44 224.42

Biomass(above ground living) (Mt)
Forest 8,519.31 535.00 0.10 416.59 292.33 904.80 1,605.88 493.10 523.11 716.51 870.59 79.46 124.61 102.93 271.18 156.78 31.47 54.78 511.16 333.65 53.06 220.81 221.43

 Forest&Woodland 8,921.14 557.53 0.24 439.66 293.88 922.82 1,813.37 499.85 535.83 805.65 879.27 79.46 124.61 102.93 273.04 156.83 31.47 54.78 515.55 333.95 53.06 223.44 223.95
* Forest&Woodland&Scrub&Savanna 8,994.37 565.98 1.00 441.43 293.97 923.83 1,874.00 499.85 535.83 805.65 879.29 79.46 124.62 102.93 273.04 156.84 31.47 54.78 515.56 333.95 53.06 223.44 224.42

Forest BaseMap(ver.1: Landcover + Draft Cropland/Agriculture landuse): Carbon Stock (above ground living) x Province

VEG VEGNAME SUM CEN NCD ORO MIL GUL WES MOR MAD ESK WSK SIM ENG EHY SHY HLA WHY JWK WNB ENB MAN NIR ARB

P Low Altitude Forest on Plains & Fans 1,241.89 41.42 0.01 51.63 31.19 151.67 454.02 12.95 68.67 99.79 145.67 1.18 0.39 0.30 21.70 3.16 1.34 1.31 73.77 19.11 9.57 19.93 33.12
H Low Altitude Forest on Uplands 1,749.00 155.11 0.01 102.62 92.04 171.33 88.75 118.98 129.72 144.62 202.05 16.49 9.81 7.94 61.55 20.46 3.09 9.96 154.53 116.94 15.04 74.69 53.27
L Lower Montane Forest 541.00 44.73 0.00 31.95 8.92 10.15 19.09 93.50 31.71 15.15 40.20 18.63 41.07 39.26 41.22 48.75 9.29 13.24 4.50 17.73 0.00 6.78 5.11
Mo Montane Forest 23.56 2.57 0.00 1.98 0.04 0.00 0.18 2.58 1.44 0.04 1.19 1.04 7.25 0.88 0.79 1.28 1.06 1.23 0.00 0.00 0.00 0.00 0.00
D Dry Seasonal Forest 80.99 0.00 0.00 0.00 0.00 0.00 80.99 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
B Littoral Forest 5.92 1.01 0.00 0.06 0.37 0.09 3.17 0.09 0.09 0.17 0.19 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.09 0.21 0.00 0.00 0.38
Fri Seral Forest 22.39 0.95 0.00 3.73 0.16 0.05 1.39 0.52 0.81 3.43 0.42 0.00 0.00 0.00 0.00 0.00 0.00 0.00 2.97 2.58 0.00 0.97 4.41
Fsw Swamp Forest 291.98 1.28 0.00 2.57 0.16 70.24 96.56 2.88 13.41 71.94 19.39 0.00 0.05 0.00 2.18 0.03 0.01 0.01 3.64 0.01 0.00 0.09 7.53
M Mangrove Forest 45.42 4.20 0.03 1.21 4.33 20.85 10.19 0.25 0.01 1.54 0.06 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.72 0.22 0.31 1.27 0.23
W Woodland 188.86 10.59 0.07 10.84 0.73 8.47 97.52 3.17 5.98 41.89 4.08 0.00 0.00 0.00 0.88 0.02 0.00 0.00 2.06 0.14 0.00 1.24 1.18
Sa Savanna 21.45 3.75 0.33 0.78 0.00 0.48 16.11 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Sc Scrub 12.97 0.22 0.03 0.05 0.04 0.00 12.38 0.00 0.00 0.00 0.01 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.22
G Grassland and Herbland 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Ga Grassland (Alpine) 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Gi Grassland (Subalpine) 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Z Bare areas 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
U Larger Urban Centres 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
E Lake & Larger Rivers 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
O Cropland/Agriculture land 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Qf Forest Plantation 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Qa Plantation other than Qf 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

SUM 4,225.44 265.83 0.47 207.42 137.99 433.32 880.35 234.92 251.84 378.59 413.26 37.34 58.57 48.38 128.33 73.71 14.79 25.75 242.28 156.95 24.93 104.96 105.47

Carbon Stock (above ground living) (Mt)
Forest 4002.16 251.27 0.05 195.75 137.21 424.38 754.33 231.75 245.86 336.70 409.18 37.34 58.57 48.38 127.45 73.69 14.79 25.75 240.21 156.81 24.93 103.73 104.06

 Forest&Woodland 4191.02 261.86 0.11 206.59 137.94 432.85 851.85 234.92 251.84 378.59 413.25 37.34 58.57 48.38 128.33 73.71 14.79 25.75 242.28 156.95 24.93 104.96 105.25
* Forest&Woodland&Scrub&Savanna 4225.44 265.83 0.47 207.42 137.99 433.32 880.35 234.92 251.84 378.59 413.26 37.34 58.57 48.38 128.33 73.71 14.79 25.75 242.28 156.95 24.93 104.96 105.47

Above Ground Living Carbon Stock



Below Ground Living Biomass

Below Ground Living Carbon Stock

Forest BaseMap(ver.1: Landcover + Draft Cropland/Agriculture landuse): Biomass (below ground living) x Province

VEG VEGNAME SUM CEN NCD ORO MIL GUL WES MOR MAD ESK WSK SIM ENG EHY SHY HLA WHY JWK WNB ENB MAN NIR ARB

P Low Altitude Forest on Plains & Fans 977.66 32.61 0.01 40.64 24.55 119.40 357.42 10.19 54.06 78.56 114.68 0.93 0.30 0.23 17.09 2.49 1.05 1.03 58.07 15.04 7.54 15.69 26.08
H Low Altitude Forest on Uplands 1,376.87 122.10 0.01 80.78 72.46 134.88 69.86 93.66 102.12 113.85 159.06 12.98 7.72 6.25 48.46 16.11 2.43 7.84 121.65 92.06 11.84 58.80 41.93
L Lower Montane Forest 310.79 25.70 0.00 18.36 5.13 5.83 10.97 53.71 18.22 8.71 23.10 10.70 23.59 22.55 23.68 28.00 5.34 7.61 2.58 10.19 0.00 3.89 2.93
Mo Montane Forest 13.53 1.48 0.00 1.14 0.02 0.00 0.10 1.48 0.83 0.02 0.68 0.60 4.16 0.50 0.46 0.74 0.61 0.71 0.00 0.00 0.00 0.00 0.00
D Dry Seasonal Forest 41.36 0.00 0.00 0.00 0.00 0.00 41.36 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
B Littoral Forest 3.02 0.52 0.00 0.03 0.19 0.04 1.62 0.05 0.05 0.09 0.10 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.05 0.11 0.00 0.00 0.20
Fri Seral Forest 17.62 0.75 0.00 2.93 0.13 0.04 1.09 0.41 0.64 2.70 0.33 0.00 0.00 0.00 0.00 0.00 0.00 0.00 2.34 2.03 0.00 0.76 3.47
Fsw Swamp Forest 229.86 1.01 0.00 2.02 0.12 55.30 76.02 2.27 10.56 56.63 15.27 0.00 0.04 0.00 1.71 0.03 0.01 0.01 2.86 0.01 0.00 0.07 5.93
M Mangrove Forest 49.35 4.56 0.03 1.32 4.70 22.65 11.07 0.27 0.02 1.67 0.06 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.78 0.24 0.34 1.37 0.25
W Woodland 112.51 6.31 0.04 6.46 0.43 5.04 58.10 1.89 3.56 24.96 2.43 0.00 0.00 0.00 0.52 0.01 0.00 0.00 1.23 0.08 0.00 0.74 0.71
Sa Savanna 18.25 3.19 0.28 0.66 0.00 0.40 13.71 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Sc Scrub 11.04 0.19 0.03 0.05 0.04 0.00 10.54 0.00 0.00 0.00 0.01 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.19
G Grassland and Herbland 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Ga Grassland (Alpine) 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Gi Grassland (Subalpine) 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Z Bare areas 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
U Larger Urban Centres 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
E Lake & Larger Rivers 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
O Cropland/Agriculture land 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Qf Forest Plantation 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Qa Plantation other than Qf 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

SUM 3,161.88 198.41 0.39 154.39 107.78 343.59 651.86 163.94 190.04 287.20 315.71 25.21 35.83 29.54 91.92 47.38 9.44 17.19 189.57 119.76 19.72 81.33 81.69

Biomass (below ground living) (Mt)
Forest 3,020.07 188.72 0.04 147.23 107.30 338.14 569.51 162.05 186.48 262.24 313.28 25.21 35.82 29.54 91.40 47.36 9.44 17.19 188.34 119.68 19.72 80.59 80.80

 Forest&Woodland 3,132.58 195.03 0.08 153.68 107.74 343.18 627.60 163.94 190.04 287.20 315.71 25.21 35.82 29.54 91.92 47.38 9.44 17.19 189.57 119.76 19.72 81.33 81.50
* Forest&Woodland&Scrub&Savanna 3,161.88 198.41 0.39 154.39 107.78 343.59 651.86 163.94 190.04 287.20 315.71 25.21 35.83 29.54 91.92 47.38 9.44 17.19 189.57 119.76 19.72 81.33 81.69

Forest BaseMap(ver.1: Landcover + Draft Cropland/Agriculture landuse): Carbon Stock (below ground living) x Province

VEG VEGNAME SUM CEN NCD ORO MIL GUL WES MOR MAD ESK WSK SIM ENG EHY SHY HLA WHY JWK WNB ENB MAN NIR ARB

P Low Altitude Forest on Plains & Fans 459.50 15.32 0.00 19.10 11.54 56.12 167.99 4.79 25.41 36.92 53.90 0.44 0.14 0.11 8.03 1.17 0.49 0.48 27.29 7.07 3.54 7.38 12.26
H Low Altitude Forest on Uplands 647.13 57.39 0.00 37.97 34.06 63.39 32.84 44.02 48.00 53.51 74.76 6.10 3.63 2.94 22.78 7.57 1.14 3.69 57.17 43.27 5.57 27.64 19.71
L Lower Montane Forest 146.07 12.08 0.00 8.63 2.41 2.74 5.15 25.24 8.56 4.09 10.85 5.03 11.09 10.60 11.13 13.16 2.51 3.58 1.21 4.79 0.00 1.83 1.38
Mo Montane Forest 6.36 0.69 0.00 0.54 0.01 0.00 0.05 0.70 0.39 0.01 0.32 0.28 1.96 0.24 0.21 0.35 0.29 0.33 0.00 0.00 0.00 0.00 0.00
D Dry Seasonal Forest 19.44 0.00 0.00 0.00 0.00 0.00 19.44 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
B Littoral Forest 1.42 0.24 0.00 0.01 0.09 0.02 0.76 0.02 0.02 0.04 0.05 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.02 0.05 0.00 0.00 0.09
Fri Seral Forest 8.28 0.35 0.00 1.38 0.06 0.02 0.51 0.19 0.30 1.27 0.16 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1.10 0.95 0.00 0.36 1.63
Fsw Swamp Forest 108.03 0.47 0.00 0.95 0.06 25.99 35.73 1.07 4.96 26.62 7.18 0.00 0.02 0.00 0.81 0.01 0.00 0.00 1.35 0.00 0.00 0.03 2.79
M Mangrove Forest 22.26 2.06 0.01 0.60 2.12 10.22 4.99 0.12 0.01 0.75 0.03 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.35 0.11 0.15 0.62 0.11
W Woodland 52.88 2.97 0.02 3.04 0.20 2.37 27.31 0.89 1.67 11.73 1.14 0.00 0.00 0.00 0.25 0.01 0.00 0.00 0.58 0.04 0.00 0.35 0.33
Sa Savanna 8.58 1.50 0.13 0.31 0.00 0.19 6.44 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Sc Scrub 5.19 0.09 0.01 0.02 0.02 0.00 4.95 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.09
G Grassland and Herbland 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Ga Grassland (Alpine) 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Gi Grassland (Subalpine) 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Z Bare areas 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
U Larger Urban Centres 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
E Lake & Larger Rivers 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
O Cropland/Agriculture land 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Qf Forest Plantation 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Qa Plantation other than Qf 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

SUM 1,485.14 93.17 0.18 72.54 50.57 161.06 306.16 77.04 89.32 134.95 148.38 11.85 16.84 13.88 43.20 22.27 4.44 8.08 89.08 56.28 9.26 38.20 38.39

Carbon Stock (below ground living) (Mt)
Forest 1418.50 88.61 0.02 69.17 50.34 158.50 267.46 76.16 87.64 123.22 147.24 11.85 16.84 13.88 42.96 22.26 4.44 8.08 88.50 56.24 9.26 37.85 37.97

 Forest&Woodland 1471.38 91.58 0.04 72.21 50.55 160.87 294.76 77.04 89.32 134.95 148.38 11.85 16.84 13.88 43.20 22.27 4.44 8.08 89.08 56.28 9.26 38.20 38.30
* Forest&Woodland&Scrub&Savanna 1485.14 93.17 0.18 72.54 50.57 161.06 306.16 77.04 89.32 134.95 148.38 11.85 16.84 13.88 43.20 22.27 4.44 8.08 89.08 56.28 9.26 38.20 38.39



Above and Below Ground Living Biomass

Above and Below Ground Living Carbon Stock

Forest BaseMap(ver.1: Landcover + Draft Cropland/Agriculture landuse): Biomass (above and below ground living) x Province

VEG VEGNAME SUM CEN NCD ORO MIL GUL WES MOR MAD ESK WSK SIM ENG EHY SHY HLA WHY JWK WNB ENB MAN NIR ARB

P Low Altitude Forest on Plains & Fans 3,619.98 120.73 0.04 150.49 90.91 442.09 1323.42 37.74 200.16 290.89 424.62 3.43 1.12 0.86 63.27 9.22 3.90 3.81 215.02 55.70 27.90 58.11 96.55
H Low Altitude Forest on Uplands 5,098.14 452.12 0.02 299.11 268.29 499.41 258.68 346.80 378.12 421.56 588.97 48.07 28.59 23.14 179.43 59.64 9.01 29.04 450.43 340.88 43.84 217.72 155.27
L Lower Montane Forest 1,461.84 120.87 0.00 86.35 24.11 27.44 51.58 252.64 85.68 40.95 108.63 50.34 110.98 106.09 111.39 131.72 25.11 35.78 12.15 47.92 0.00 18.31 13.80
Mo Montane Forest 63.66 6.95 0.00 5.36 0.11 0.00 0.48 6.98 3.88 0.12 3.21 2.82 19.59 2.37 2.14 3.47 2.86 3.32 0.00 0.00 0.00 0.00 0.00
D Dry Seasonal Forest 213.69 0.00 0.00 0.00 0.00 0.00 213.69 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
B Littoral Forest 15.62 2.68 0.00 0.15 0.96 0.23 8.37 0.24 0.24 0.46 0.50 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.25 0.55 0.00 0.00 1.01
Fri Seral Forest 65.26 2.77 0.00 10.86 0.47 0.15 4.04 1.50 2.38 10.00 1.22 0.00 0.00 0.00 0.00 0.00 0.00 0.00 8.67 7.52 0.00 2.82 12.86
Fsw Swamp Forest 851.10 3.73 0.00 7.48 0.46 204.75 281.47 8.40 39.08 209.69 56.53 0.00 0.15 0.00 6.35 0.10 0.04 0.02 10.60 0.02 0.00 0.26 21.96
M Mangrove Forest 150.07 13.88 0.08 4.01 14.30 68.88 33.66 0.83 0.05 5.09 0.19 0.00 0.00 0.00 0.00 0.00 0.00 0.00 2.38 0.73 1.03 4.18 0.76
W Woodland 514.35 28.84 0.18 29.53 1.98 23.06 265.58 8.64 16.28 114.10 11.10 0.00 0.00 0.00 2.39 0.06 0.00 0.00 5.62 0.38 0.00 3.37 3.22
Sa Savanna 63.88 11.17 0.97 2.31 0.01 1.42 47.99 0.00 0.00 0.00 0.00 0.00 0.01 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Sc Scrub 38.65 0.66 0.10 0.16 0.13 0.00 36.89 0.00 0.00 0.00 0.03 0.00 0.00 0.00 0.00 0.01 0.00 0.00 0.01 0.00 0.00 0.00 0.66
G Grassland and Herbland 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Ga Grassland (Alpine) 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Gi Grassland (Subalpine) 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Z Bare areas 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
U Larger Urban Centres 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
E Lake & Larger Rivers 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
O Cropland/Agriculture land 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Qf Forest Plantation 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Qa Plantation other than Qf 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

SUM 12,156.25 764.39 1.39 595.82 401.75 1267.42 2525.85 663.79 725.87 1092.84 1195.00 104.67 160.45 132.47 364.96 204.22 40.91 71.97 705.13 453.71 72.78 304.77 306.11

Biomass(above & below ground living) (Mt)
Forest 11,539.38 723.72 0.14 563.82 399.63 1,242.94 2,175.39 655.15 709.59 978.75 1,183.87 104.67 160.43 132.47 362.57 204.14 40.91 71.97 699.49 453.33 72.78 301.40 302.22

 Forest&Woodland 12,053.73 752.56 0.32 593.35 401.61 1,266.00 2,440.97 663.78 725.87 1,092.84 1,194.97 104.67 160.43 132.47 364.96 204.21 40.91 71.97 705.12 453.71 72.78 304.77 305.45
* Forest&Woodland&Scrub&Savanna 12,156.25 764.39 1.39 595.82 401.75 1,267.42 2,525.85 663.79 725.87 1,092.84 1,195.00 104.67 160.45 132.47 364.96 204.22 40.91 71.97 705.13 453.71 72.78 304.77 306.11

Forest BaseMap(ver.1: Landcover + Draft Cropland/Agriculture landuse): Carbon Stock (above & below ground living) x Province

VEG VEGNAME SUM CEN NCD ORO MIL GUL WES MOR MAD ESK WSK SIM ENG EHY SHY HLA WHY JWK WNB ENB MAN NIR ARB

P Low Altitude Forest on Plains & Fans 1,701.39 56.74 0.02 70.73 42.73 207.78 622.01 17.74 94.07 136.72 199.57 1.61 0.53 0.41 29.73 4.33 1.83 1.79 101.06 26.18 13.11 27.31 45.38
H Low Altitude Forest on Uplands 2,396.13 212.49 0.01 140.58 126.10 234.72 121.58 163.00 177.72 198.13 276.81 22.59 13.44 10.88 84.33 28.03 4.23 13.65 211.70 160.21 20.61 102.33 72.98
L Lower Montane Forest 687.07 56.81 0.00 40.58 11.33 12.90 24.24 118.74 40.27 19.25 51.06 23.66 52.16 49.86 52.35 61.91 11.80 16.82 5.71 22.52 0.00 8.61 6.49
Mo Montane Forest 29.92 3.27 0.00 2.52 0.05 0.00 0.22 3.28 1.82 0.05 1.51 1.33 9.21 1.11 1.01 1.63 1.35 1.56 0.00 0.00 0.00 0.00 0.00
D Dry Seasonal Forest 100.43 0.00 0.00 0.00 0.00 0.00 100.43 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
B Littoral Forest 7.34 1.26 0.00 0.07 0.45 0.11 3.93 0.11 0.11 0.21 0.23 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.12 0.26 0.00 0.00 0.48
Fri Seral Forest 30.67 1.30 0.00 5.10 0.22 0.07 1.90 0.71 1.12 4.70 0.57 0.00 0.00 0.00 0.00 0.00 0.00 0.00 4.08 3.53 0.00 1.32 6.05
Fsw Swamp Forest 400.02 1.75 0.00 3.52 0.22 96.23 132.29 3.95 18.37 98.55 26.57 0.00 0.07 0.00 2.98 0.05 0.02 0.01 4.98 0.01 0.00 0.12 10.32
M Mangrove Forest 67.68 6.26 0.04 1.81 6.45 31.07 15.18 0.38 0.02 2.30 0.08 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1.07 0.33 0.47 1.89 0.34
W Woodland 241.74 13.56 0.09 13.88 0.93 10.84 124.82 4.06 7.65 53.62 5.22 0.00 0.00 0.00 1.12 0.03 0.00 0.00 2.64 0.18 0.00 1.58 1.52
Sa Savanna 30.02 5.25 0.46 1.09 0.00 0.67 22.56 0.00 0.00 0.00 0.00 0.00 0.01 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Sc Scrub 18.16 0.31 0.05 0.07 0.06 0.00 17.34 0.00 0.00 0.00 0.01 0.00 0.00 0.00 0.00 0.01 0.00 0.00 0.01 0.00 0.00 0.00 0.31
G Grassland and Herbland 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Ga Grassland (Alpine) 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Gi Grassland (Subalpine) 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Z Bare areas 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
U Larger Urban Centres 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
E Lake & Larger Rivers 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
O Cropland/Agriculture land 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Qf Forest Plantation 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Qa Plantation other than Qf 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

SUM 5,710.59 359.00 0.65 279.96 188.55 594.38 1186.51 311.96 341.16 513.54 561.65 49.19 75.41 62.26 171.53 95.98 19.23 33.83 331.36 213.23 34.19 143.16 143.86

Carbon (above & below ground living) (Mt)
Forest 5,420.66 339.88 0.07 264.92 187.55 582.87 1,021.79 307.90 333.50 459.92 556.42 49.19 75.40 62.26 170.41 95.95 19.23 33.83 328.72 213.05 34.19 141.58 142.03

 Forest&Woodland 5,662.40 353.44 0.15 278.80 188.49 593.71 1,146.62 311.96 341.16 513.54 561.63 49.19 75.40 62.26 171.53 95.98 19.23 33.83 331.36 213.23 34.19 143.16 143.55
* Forest&Woodland&Scrub&Savanna 5,710.59 359.00 0.65 279.96 188.55 594.38 1,186.51 311.96 341.16 513.54 561.65 49.19 75.41 62.26 171.53 95.98 19.23 33.83 331.36 213.23 34.19 143.16 143.86
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